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Chapter 26

Using the Cut Page
The Cut page is a focused environment for fast editing. It’s useful 
in situations where you need to quickly cut a news segment, 
build an episode of web content, edit a straightforward program, 
experiment with multiple arrangements of a scene, or put together 
a first assembly edit. 

The Cut page is also a good introductory editing interface for people who are new to editing, as it 
presents a streamlined set of tools that are fast to learn and simple to use. Whatever your background, 
you’ll find the Cut page to be a valuable addition to your editing experience in DaVinci Resolve.
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Overview of the Cut Page
With the addition of the Cut page, DaVinci Resolve now has two editing environments, intended for 
two different audiences. While the Cut and Edit pages share many of the same panels such as the 
Media Pool, the Timeline, and the Viewer, the controls that are exposed on the Cut page have been 
designed for speed, so you can cut professional programs faster than you’ve ever been able to before.

Overview of the Cut Page User Interface
The default workspace of the Cut page consists of the Media Pool, a single Viewer, and the Timeline 
area. These three regions let you quickly import and organize clips, edit clips, and even export the 
result, all from within the Cut page.

The Cut page default workspace with the Media Pool in Metadata view

Customizing the UI
A User Interface toolbar at the top of the Cut page lets you hide and show different panels as 
necessary. For example, you can hide the Media Pool if you wanted more room for the Viewer. You 
can also replace the Media Pool with other browsers in the Media Pool’s default area, showing the 
Sync Bin, Transitions, Titles, or Effects Browser in order to add those effects to your program in the 
Timeline. On the right side of the User Interface toolbar you can perform a Quick Export, expand the 
Viewer to Full Screen, or open the Inspector.

Separate buttons on the left let you open the Media Pool, Sync Bin, Transitions, Titles, and Effects browser.
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You can resize the Media Pool and Viewer by dragging the vertical seam that connects them to the left 
or right, in the process making one panel bigger and the neighboring panel smaller. 

The Viewer resize handle The Timeline resize handle

You can also resize the Timeline area by dragging the timeline handle (at the upper right corner of 
the Timeline) up or down, making more or less room for the Timeline while simultaneously resizing the 
Media Pool and Viewer areas.

Choose Settings Before You Start
When you first create a new project, you need to define its Timeline settings; you can optionally 
choose from common presets or a fully custom setup.

Timeline Resolution Quick Menu
This drop-down menu, to the top-right of the Viewer, lets you quickly choose which resolution you 
want to work at. A Custom option lets you open up the Timeline Settings panel in order to choose your 
own options. For more information about the Timeline Settings, see Chapter 6, “Project Settings.”

The Project Settings quick menu
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The Media Pool
The Media Pool contains all video clips, audio clips, graphics, and other media that you import into 
your project. You can create bins with which to organize all of this media, to make it easier to find what 
you need quickly. These bins are opened via the bin drop-down at the upper left-hand corner.

Each piece of media you import, whether it’s video, audio, or graphics, appears as an individual clip 
and can be selected, scrubbed for fast viewing, reorganized into bins, opened into the Viewer for 
playback, or edited into a timeline using the edit buttons or via drag and drop.

The Media Pool in Thumbnail view

Three buttons at the upper right of the Media Pool let you see your clips in different ways, depending 
on what you need to accomplish.

The Viewing Modes buttons

Metadata view: Each clip is represented by its own card with a scrubbable 
thumbnail and basic clip metadata information visible. This view is designed to have 
more metadata information than a thumbnail view but more targeted information 
than the List view. 

Thumbnail view: Each clip is represented by a scrubbable thumbnail. Hover the 
playhead over each thumbnail and move it left and right to see the clip’s image play, 
and use the I and O keys to mark sections of a clip that you want to use. Clicking on 
the lower right corner of a thumbnail reveals the clip’s metadata.
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Filmstrip view: Each clip is represented by a filmstrip of consecutive frames the 
length of the Media Pool. Hover the playhead over the clip and move it left and 
right to see the clip’s image play, and use the I and O keys to mark sections of a clip 
that you want to use.

List view: Each clip appears as an item in a multi-column list showing a variety 
of metadata about each clip. In List view, you can click the header of any column 
to sort the contents by that column’s information (clicking again toggles the sort 
order between Ascending and Descending). Scrolling right reveals additional 
columns of information.

A Sort Media By drop-down menu lets you choose which criteria defines the order in which clips in the 
Media Pool are arranged. Options include: Timecode, Camera, Date Time, Clip Name, Bin, Scene Shot, 
Clip Color, Date Modified, Date Imported, and Online Status. You can choose to sort in Ascending 
(bottom to top) or Descending (top to bottom) order.

Lastly, a search field lets you type a term you want to use to find one or more clips that match that 
criteria. When you type anything, the contents of the Media Pool shrink to show only clips that match 
your criteria.

The Sort Media By drop-down menu 

480The Cut Page | Chapter 26 Using the Cut Page



The Viewer
The Viewer lets you see clips from the Media Pool, or clips in the Timeline, and has numerous controls 
to control what you see and how things play. 

The single Viewer in the Cut page

The Viewer has four mode options. Which option is currently in use can be seen, and switched, 
by four buttons in the upper lefthand corner of the Viewer. 

The Viewer modes buttons

The Different options are entered automatically by various actions (from left to right):

 — You can double-click any clip to open it into the Viewer as a Source Clip.

 — You can view an entire bin full of clips in the Source Tape.

 — You can play your edited program in the Timeline.

 — You can select various framing guides and safe areas for the Viewer.

Playing Clips and Navigating the Timeline
Several controls sit at the bottom of the Viewer. These let you play through and otherwise navigate 
clips and the Timeline in different ways. These controls are described from left to right.

 

The toolbar at the bottom of the Viewer
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 — Fast Review button: Intended to help you watch through a large collection of media quickly, 
clicking this button begins accelerated playback through the Source Tape or through the Timeline, 
where the speed of playback is relative to the length of each clip you’re playing through. Long 
clips play faster, whereas shorter clips play closer to real time. In this way, you can watch a lot of 
material really quickly.

 — Tools button: The Tools button reveals a variety of controls for transform, crop, audio, speed 
effects, camera stabilization and lens correction, dynamic zoom, and compositing, covered in 
more detail later in this chapter.

 — Jog control: Clicking and dragging within the jog control lets you scrub very precisely through the 
content of the Viewer.

 — Transport controls: A set of Previous Edit (Up Arrow), Stop (Spacebar), Play (Spacebar), Next 
Edit (Down Arrow), and Loop Playback (Command-/) buttons constitute clickable controls for 
controlling playback of clips and the Timeline. Each button has a matching keyboard shortcut.

 — Mark In/Out: Clickable controls to set In and Out points respectively. 

 — Playhead timecode: A number field shows you the timecode value at the playhead of a clip or of 
the Timeline to give you a numeric reference for where you are.

Tools
Clicking the Tools button reveals a toolbar that you can use to add and edit clip effects, right within 
the Viewer with no Inspector needed. The Tools button reveals a variety of controls for transform, 
crop, audio, speed effects, camera stabilization and lens correction, dynamic zoom, and compositing, 
covered in more detail later in this chapter.

The Tools bar shown opened

Bypass Color Grades and Fusion
The Bypass Color Grades and Fusion Effects button/drop-down lets you turn off all grades and 
effects that you may have applied in the Color page and/or Fusion page in order to improve playback 
performance on low power computers. Click the button (Shift-D) to disable or reenable grading and 
effects, or right-click this button to access a menu that lets you choose which things you want this 
button to control.

The Bypass Grades and Fusion button, shown 
being right-clicked to view its options
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Export The Current Frame from The Viewer
You can now export a still frame from the Viewer in the Media, Cut, and Edit pages. 

To Export a Still Frame from the Viewer:

1 Use the Viewer’s playback controls to navigate to the frame you want to export.

2 Select File > Export > Current Frame as Still.

3 Enter the name of the still frame in the File System viewer.

4 Enter the desired format of the still frame in the File System viewer.

5 Click on the Export button.

Audio Meter
An audio meter to the right of the Viewer shows you a graphical representation of the 
audio levels playing in the current clip or in the Timeline as you play through the Viewer, 
via animated vertical bars that are tinted to indicate how loud the levels are:

 — Green indicates safe levels

 — Yellow indicates levels that are peaking at approximately safe levels

 — Red indicates levels that may be peaking at levels that are too high, risking clipping 
the signal and causing distortion

These animated bars serve as a visual reference you can use to help you adjust the 
volume of different clips to create a pleasing balance, and to make sure you don’t 
exceed the maximum desired level and introduce clipping. A speaker button at the top 
of the meters lets you mute or unmute audio playback.

The Audio Meter  
showing an audio signal

The Timeline
The word “timeline” refers both to an edited sequence of clips, which constitutes a program that is 
stored in the Media Pool, and to the area of the Cut page interface where you can open this sequence 
of clips to see its contents, and for playback and editing. 

Timelines are created and stored in the Media Pool, along with all of your other clips. However, each 
timeline is assembled and edited in what is sometimes referred to as the Timeline Editor. Different 
pages of DaVinci Resolve show your timeline differently according to the special requirements of each 
page focusing variously on different methods of editing, grading, compositing, and audio. 
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However, while the interface of the Timeline Editor changes from page to page, the actual contents 
of the Timeline are identical, because each page’s Timeline Editor is in fact showing the exact same 
Timeline that is currently open. This means that the advanced user can use every page of DaVinci to 
do different things to the same Timeline, with only the interface changing to make different functions 
possible in different pages.

For the Cut page user, the Timeline is divided into an Upper Timeline at the top, and a larger and more 
detailed Timeline Editor showing a zoomed in portion of the Timeline around the playhead at the 
bottom. Working together, these two views of your edited sequence make it possible to navigate your 
entire project and cut in great detail. 

The Timeline of the Cut page, comprising the Upper Timeline and the zoomed in Timeline

Upper Timeline
The Upper Timeline always shows the entire program within the full width of your computer’s display. 
The Upper Timeline’s playhead is always free, which makes it easy to use your pointer to scroll around 
the entire program by dragging within the Timeline Ruler at top. This also serves as a visual reference 
for keeping track of where you are in your program while you’re editing within the zoomed-in Lower 
Timeline below.

Despite the Upper Timeline’s relatively small size, you can still edit in it, with most editing and 
trimming functions that are available in the Lower Timeline also available in the Upper Timeline. Most 
interestingly, it’s also possible to drag clips from one part of your program in the Lower Timeline, to 
another area of your program in the Upper Timeline, and vice versa.

A set of small numbers to the left of the Upper Timeline lets you click a number to choose the 
currently selected track; this selection is mirrored on the zoomed in timeline below. The currently 
selected track affects where incoming clips will be placed when editing, among other things.

Lower Timeline
The zoomed in Lower Timeline (often referred to simply as “the Timeline”) shows you a close-up view 
of the portion of the currently open timeline that immediately surrounds the playhead. The zoom level 
is fixed; you cannot change it. The zoomed-in lower timeline is intended for detailed editing, but clips 
can be dragged between the Timeline and Upper Timeline for fast reordering of clips across the entire 
duration of your program.

Toolbar
The Toolbar contains several editing functions grouped together in Action and Option menus. 
These functions are accessed by clicking on the appropriate icon and selecting a function from the 
drop-down menu.
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The menu icons are:

 — Timeline Options: The tools under this icon deal with how the clips and timeline are displayed, 
and certain modes and tools that apply to the whole timeline.

All of the Timeline Options functions

 — Timeline Actions: The tools under this icon are generally used to add new items or make 
modifications to the Timeline.

All of the Timeline Actions functions
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 — Edit Actions: The tools under this icon are used to adjust clips on the Timeline.

All of the Edit Actions functions 

Tracks
The Timeline is divided into multiple tracks, with each track capable of holding a sequence of clips in 
order to create a program. The main tracks, which are labeled numerically, combine a clip’s video and 
audio into a single item in the Timeline, for simplicity. Editing the In or Out point of a clip edits the 
video and audio together.

Cut Page Timeline tracks. Track ST1 shows a subtitle track. Track V1 shows both Video only and 
combined Video+Audio clips in an enlarged view. Track A4 shows a separate audio track.

TIP: In the Edit page, Video+Audio clips are presented as separated Video and Audio items 
on different tracks. When you open the Fairlight page, audio is presented on tracks with 
lanes, where each audio channel can be seen. In this way, each page gives you different 
sets of controls over the contents of the Timeline that are appropriate for each page.

Track Header Controls
The track controls, in order, allow you to enlarge a track, lock the track for edits, mute audio, and 
enable or disable video for the track.

Controls to enlarge, lock, 
mute audio, and disable 
video for the track

486The Cut Page | Chapter 26 Using the Cut Page



The Importance of Track 1
Each track in the Timeline of the Cut page is designed to carry specific parts of your program. Track 1 
is intended for the primary video+audio of your program, often called the “A-roll,” since these are the 
primary shots comprising the timing and pacing of the story you’re telling. Adding, deleting, inserting, 
trimming, or otherwise rearranging clips on Track 1 results in the rest of the edited timeline being 
automatically rippled to accommodate the change you’ve made, with clips to the right of the changed 
area moving left to fill the gap of a deleted or shortened clips, or moving right to make room for an 
inserted or lengthened clip.

Tracks 2 and Above
Tracks 2 and above are intended for “B-roll,” which is additional footage you stack on top of other clips 
in Track 1 to illustrate what someone is saying in the audio of Track 1, or for superimpositions used for 
compositing effects that combine two images together in creative ways. Moving or resizing clips on 
Track 2 and above only moves or resizes that one clip; other clips in the Timeline are not rearranged 
and the Timeline is not rippled when you do this.

For instances where multiple video clips overlap one another on multiple tracks, the video clip on 
the highest track obscures those on lower tracks, meaning that only the top clips appear during 
playback. This is useful when you’re experimenting with rearranging multiple clips in a complex scene. 
For example, you could be editing a scene where an interview clip is on the bottom track, and various 
b-roll clips are edited on tracks above the interview so you can freely rearrange them in different ways, 
while it’s always easy to reveal the speaker on the bottom track by leaving a gap in the superimposed 
b-roll clips.

Editing a scene with multiple superimposed clips

However, if you superimpose video-only or video+audio clips for compositing, you can use the 
composite modes and the opacity slider found in the Composite section of the Viewer Tools controls 
to mix multiple images together in different ways for artistic effects.
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(Left) Superimposing clips you want to composite, (Right) Creating 
compositing effects with multiple superimposed clips

You can add additional Video+Audio tracks, when necessary, by either dragging a clip to the undefined 
gray area of the Timeline above the other existing tracks to make a new track automatically, by clicking 
the New Track button at the upper lefthand corner of the Timeline, or by right-clicking in the timeline 
header area and choosing “Add Video Track” from the contextual menu.

Audio-Only Tracks
You can also edit audio-only clips such as music, narration, or sound effects, onto separate audio-
only tracks underneath, which are then labeled A1, A2, A3, etcetera. If you drag an audio clip to 
the undefined gray area of the Timeline below the other existing tracks, an audio-only track will 
automatically be created.

Audio-only tracks in the Cut page Timeline

Gaps
Because Track 1 is meant to hold the principal clips for your program, the Timeline automatically 
ripples itself to close gaps that would otherwise result when you move or rearrange clips in 
Track 1, and superimposed clips in Tracks 2 and above move to keep in sync with the clips they’re 
superimposed over. However, you can move superimposed clips on Tracks 2 and above to place them 
wherever you want, and gaps will be left between multiple clips on the same superimposed track so 
they can be edited at specific places.

Timeline Controls
The Timeline controls in the upper left-hand corner of the Timeline let you enable/disable Rippling on 
Track 1, Split a clip at the playhead position, and create Markers that let you keep track of important 
frames of the Timeline.

The Cut page Timeline controls
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Undo and Redo in DaVinci Resolve
No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of 
steps you’ve taken or commands you’ve executed, and reapply them if you change your mind. 
DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or 
opening a particular project. When you close a project, its entire undo history is purged. The next time 
you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three separate 
sets of undo “stacks” to help you manage your work.

 — The Media, Edit and Fairlight pages share the same multiple-undo stack, which lets you backtrack 
out of changes made in the Media Pool, the Timeline, the Metadata Editor, and the Viewers.

 — Each clip in the Fusion page has its own undo stack, so you can undo changes you make to the 
composition of each clip, independently.

 — Each clip in the Color page has its own undo stack, so you can undo changes you make to grades 
in each clip, independently.

In all cases, there is no practical limit to the number of steps that are undoable (although there may be 
a limit to what you can remember). To take advantage of this, there are three ways you can undo work 
to go to a previous state of your project, no matter what page you’re in.

To simply undo or redo changes you’ve made one at a time:

 — Choose Edit > Undo (Command-Z) to undo the previous change.

 — Choose Edit > Redo (Shift-Command-Z) to redo to the next change.

 — On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

You can also undo several steps at a time using the History submenu and window. At the time of this 
writing, this only works for multiple undo steps in the Media, Cut, Edit, and Fairlight pages.

To undo and redo using the History submenu:

1 Open the Edit > History submenu, which shows (up to) the last twenty things you’ve done.

2 Choose an item on the list to undo back to that point. The most recent thing you’ve done appears 
at the top of this list, and the change you’ve just made appears with a check next to it. Steps 
that have been undone but that can still be redone remain in this menu, so you can see what’s 
possible. However, if you’ve undone several changes at once and then you make a new change, 
you cannot undo any more and those steps disappear from the menu.
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The History submenu, which lets you undo several steps at once

Once you’ve selected a step to undo to, the menu closes and the project updates to 
show you its current state.

To undo and redo using the History window:

1 Choose Edit > History > Open History Window.

2 When the History dialog appears, click an item on the list to undo back to that point. Unlike 
the menu, in this window the most recent thing you’ve done appears at the bottom of this list. 
Selecting a change here grays out changes that can still be redone, as the project updates to 
show you its current state.

The Undo history window that lets 
you browse the entire available 
undo stack of the current page

3 When you’re done, close the History window.
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Chapter 27

Importing and 
Organizing Media 
in the Cut Page 
Before you can start editing, you need to import the clips you want 
to use for your program into the Media Pool, which is the central 
repository of clips in your project. 

This can include video, audio, and graphics files in any format that’s supported by DaVinci Resolve.

Once imported, the Media Pool on the Cut page has many organizational tools you can use to make 
your project’s media faster for you to access and sort through as you find the clips you need to create 
your program.
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Importing Media
Two Import buttons at the top of the Media Pool let you use import dialogs to select media you want 
to bring into the Media Pool for use in your project. 

The Import Media and Import Folder buttons

To import individual clips:

1 Do one of the following:

a) Click the Import Media button.

b) Press Command-I.

c) Right-click the Media Pool and choose Import Media.

2 Use the Import dialog to select one or more clips to import, and click Open.

3 If you’re prompted to change the frame rate of a currently empty project to match that of the 
incoming media, click Change.

Each piece of media you import, whether it’s video, audio, or graphics, appears as an individual clip in 
the Media Pool. You can also import an entire folder full of media as a bin in the Media Pool.

To import a folder full of media into a bin:

1 Click the Import Media Folder button.

2 Use the Import dialog to select a folder containing media you want to import, and click Open.

3 If you’re prompted to change the frame rate of a currently empty project to match that of the 
incoming media, click Change.

Each folder you import appears as a bin in the Media Pool. Double-clicking a bin opens its contents 
into the Media Pool, enabling you to view each individual clip.

TIP: For additional media import features, you can use the Media page, with its Media 
Storage browser and more feature-rich version of the Media Pool.
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Removing Media
If there are clips you no longer want in your project, you can simply select them and press the Delete 
or Backspace keys. A Dialog asks if you want to remove the selected clip or clips; clicking Remove will 
remove them from the Media Pool, while leaving them intact on your media storage device.

If you want to remove every clip in the currently open bin (even the Master bin), you can also right-click 
anywhere within the Media Pool and choose Remove All Clips in Bin from the contextual menu.

Organizing Media into Bins
For short projects, having all your clips together in a single bin (the Master bin is the top level of 
the Media Pool) can be fast. However, for longer projects, organizing your media into subsets 
of clips within individual bins can make browsing each bin’s contents using the Source Tape of 
the Viewer more manageable.

TIP: You can move clips you know you don’t want, such as instances where the camera 
rolled on unusable scenery or moments, or completely unusable takes, into another bin 
so those clips don’t present themselves in the Source Tape for bins containing clips you 
want to use.

Master Bin
At the top level of your project hierarchy is the Master bin. The Master bin contains all of the media content 
(clips, timelines, graphics, other bins, etc.) for your project. In the Cut page, the Master bin also shows 
all of your project’s timelines for easy access, regardless of where they’ve been created in your project.

Creating and Using Bins
You can create bins with which to organize your media by choosing File > New Bin (Shift-Command-N), 
or by right-clicking in the Media Pool and choosing New Bin from the contextual menu. You can create 
bins inside of other bins, and in so doing hierarchically organize the clips you need in a variety of ways.

Bins seen in the Media Pool

Once you’ve created a bin, you can move one or more selected clips into it via drag and drop, just as 
you would on the desktop of your operating system’s file manager.
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Opening Bins
Any visible bin in the Media Pool can be opened by double-clicking it, or by clicking the Bin drop-down 
at the upper left-hand corner of the Media Pool and choosing a bin to open from the menu (they’re 
shown as a hierarchical list). When opened, a bin’s contents fill the Media Pool, and a path indicator 
at the top of the Media Pool lets you see how many levels deep you are in cases where you have bins 
inside of bins. You can click any level of this path to jump back up the hierarchy, or you can choose 
another bin from the Bin drop-down.

The hierarchical Bin drop-down menu

Create Bin With Selected Clips
You can also create a bin and put clips into it in one step. Select one or more clips in the Media Pool, 
right-click one of the selected clips, and choose Create Bin With Selected Clips from the contextual 
menu. A new bin appears called “Bin X” (where X is the next number that’s available) displaying the 
selected clips it now contains.

Renaming Bins
To rename a bin, click its name once, then slowly click a second time (clicking too fast is a “double-click” 
which opens the bin), and the name becomes highlighted, ready for editing. You can also right-click a 
bin and choose Rename Bin from the contextual menu, which also highlights the bin’s name, ready for 
editing. When you’re done typing a new name, press Return (or Enter).

Import and Export Specific 
DaVinci Resolve Project Bins 
You can import/export specific bins from one DaVinci Resolve project to another, allowing you to pass 
bins quickly between projects and workstations that have access to the same media. All Metadata, In/
Out points, Timelines, etc. are transferred along with the clips in the bin, but none of the actual media 
files are included.
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To export bins from the Media Pool:

1 Select one or more bins in the Media Pool.

2 Right-click the selection and choose “Export Bin,” or choose File > Export > Export Bin.

3 Choose where to save the DaVinci Resolve Bin file (.drb) in the file system dialog, and click Save.

To import bins into the Media Pool:

1 Right-click in the Media Pool and choose “Import Bin,” or choose File > Import > Import Bin.

2 Do one of the following:

 — Choose a DaVinci Resolve Bin file (.drb) from the file system dialog.

 — Double click the .drb file in your file system.

The bin or bins will appear in the Media Pool. Any bins imported this way will have the word “import” 
appended to their name, to avoid duplicate names. If you import a bin that contains clips that were 
already in the Media Pool, the potentially duplicate clips are excluded from the import and instead 
relinked to the media referenced by your project. This keeps your Media Pool tidy. However, if the bin 
or bins have been moved to another computer, you may have to relink offline media.

Import and Export Individual 
DaVinci Resolve Timelines 
You can export and import individual timelines from one DaVinci Resolve project into another 
previously existing DaVinci Resolve project, allowing you to pass timelines quickly between projects 
and workstations, without creating additional imported project files. Just the timeline and its 
associated clip information is exported, none of the actual media files are included.

To export a timeline from the Media Pool:

1 Select a timeline from the Media Pool.

2 Choose File > Export > Export AAF, XML, DRT (Shift-Command-O).

3 Choose “DaVinci Resolve Timeline Files (*.drt)” from the format options drop-down in the file 
system dialog.

4 Choose where to save the DaVinci Resolve Timeline file (.drt) in the file system dialog, 
and click Save.

To import a timeline into the Media Pool:

1 Choose a bin in the Media Pool in which you want the imported timeline to be saved.

2 Do one of the following:

 — Choose File > Import Timeline > Import AAF, XML, DRT (Shift-Command-I), then Select a 
DaVinci Resolve Timeline file (.drt) from the file system dialog, and click Open.

 — Double click the .drt file in your file system.

The timeline will appear in the Media Pool, along with all of the clips associated with it. Any timelines 
imported this way will have the word “import” appended to their name, to avoid duplicate names. 
The imported timeline will be automatically conformed to corresponding media that’s already in the 
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Media Pool. However, if the timeline has been moved to another computer, you may have to reimport 
or relink missing or offline media in to bring the imported timeline fully online.

NOTE: Only a single timeline can be imported and exported at a time using this 
method. To import or export multiple timelines, use the Import/Export Bin function 
described above.

ATEM Switcher Integration
If you’ve recorded a multi-camera event with the ATEM Mini Pro ISO or ATEM Mini Extreme ISO, 
it is possible to move that entire project into DaVinci Resolve. ATEM projects include the master 
program clip, as well as each individual camera’s “ISO” (isolated) clips, and each camera angle’s audio 
recordings. All transitions, timecode, and camera number metadata are imported, as well as whatever 
graphics were stored in the ATEM’s Media Pool. Once the project is loaded, you can seamlessly 
continue your multi-camera edit in the Cut page.

This initial live recording coupled with later post-production editing workflow is often referred to 
as “Live to Tape.” Live to Tape gives you the all the benefits of the spontaneity, verisimilitude, and 
fast turnaround inherent to live production but with the added benefit of being able to later add 
and remove sections and adjust the editorial flow of the program. Live to Tape also allows you to 
fix simple mistakes, such as choosing a better camera angle, or replacing a title or graphic with an 
updated version. Because of this flexibility, Live to Tape is the preferred method of recording almost 
all broadcast network game shows, current events shows, and sitcoms. Essentially, any type of multi-
camera production that does not primarily depend on being live in real time for its main purpose (like 
news or sports) is shot Live to Tape instead.

The Live to Tape workflow requires the following elements, all of which are provided by the ATEM Mini 
Pro ISO and ATEM Mini Extreme ISO.

 — A program master clip that was shot live, including all the mixed camera angles, audio, transitions, 
etc. from the beginning of the show until the end, for reference.

 — Separate ISO recordings from each camera used to shoot the program master clip. An ISO is an 
isolated (ISO) camera recording of the entire show from that camera’s perspective only, from the 
beginning to end and without interruption.

 — A timeline of the live recorded show that indicates where all the camera angles were switched, 
what transitions were used, and what graphics were involved.

Importing ATEM Mini Pro ISO Projects
Importing an ATEM project essentially rebuilds the master program clip as a timeline inside 
DaVinci Resolve from the camera ISOs, transitions, and graphics. This new timeline will match the 
master program clip in every way, just created from the original source materials rather than as a 
single compressed video file. 
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Refer to your ATEM’s specific documentation for how to set up ISO recording, but one important 
setting is to make sure that you’ve checked the “ISO Record All Inputs” setting in the ATEM software 
control before you start shooting.

To import an ATEM Mini Pro ISO Project:

1 (Before you shoot) Check the “ISO Record All Inputs” setting in the ATEM software control.

2 At this point, record your show using the ATEM device, and note the project’s folder location.

3 Select File > Import Project.

4 Select the DaVinci Resolve Project file (.drp) in the ATEM project folder, in the file browser.

5 Click on the Open button.

An ATEM Mini Pro project opened in the Cut page Sync bin

Relinking Blackmagic Camera 
Masters to ATEM ISOs
The ATEM records each camera’s ISO as an H.264 HD video stream, which may not be of high enough 
resolution or quality for some purposes. It’s possible to instantly switch your ATEM camera ISOs to the 
original camera recordings made in a Blackmagic Camera instead. This workflow enables the highest 
visual quality of Blackmagic RAW and the ability to output in higher resolutions (such as 4K or UHD) 
than are supported by the ATEM internally. Essentially, the ATEM can reference an additional set of 
higher quality ISOs recorded in the cameras, rather than those from the ATEM itself. This feature is 
only available using Blackmagic Cameras.

This workflow requires one more step in the process, namely making sure that you have sufficient 
recording space attached to each camera to record the show in its entirety. Refer to your ATEM’s 
specific documentation for how to set up ISO recording and camera control, but one important 
setting is to make sure that you’ve checked the “ISO Record All Inputs” and the “Record in All Cameras” 
settings in the ATEM software control before you start shooting.

497The Cut Page | Chapter 27 Importing and Organizing Media in the Cut Page 



To relink to Blackmagic Camera masters from ATEM ISO recordings:

1 (Before you shoot) Check the “Record in All Cameras” setting in the ATEM software control.

2 (Before you shoot) Check the “ISO Record All Inputs” setting in the ATEM software control.

3 At this point, record your show using the ATEM device and note the project’s folder location.

4 Copy all the resulting camera masters from each camera’s memory card to the ATEM project’s 
“Video ISO Files” folder, and then import the project into DaVinci Resolve.

5 DaVinci Resolve automatically creates a separate Blackmagic RAW folder in your project and 
moves all the camera masters to that folder.

6 Click the “Switch to Camera Originals” button in the Cut page Viewer to instantly switch between 
referencing the ATEM H.264 ISOs and the Blackmagic Camera masters.

The Show Camera Originals button

Once your project is imported successfully into DaVinci Resolve, it can be edited using the variety 
of specialized Multicam editing tools found in the Cut page, including the Sync Bin, Live Overwrite, 
and the DaVinci Resolve Speed Editor. For more information on using these tools, see Chapter 28, 
“Fast Editing in the Cut Page.”

Media Pool Views
Once you’ve imported some clips into the Media Pool, three controls at the upper right-hand side let 
you control how they look, depending on what you need to accomplish.

The View Mode buttons

Metadata View
In the Metadata view mode, each clip is represented by its own card with a thumbnail and basic 
clip metadata information visible. This view is designed to have more metadata information than 
a thumbnail but more targeted information than the List view. This feature, combined with its sort 
modes, is a powerful way to organize and reorganize your clips in the Media Pool.

The metadata fields of the Metadata view (from the top down):

 — Thumbnail: A scrubbable thumbnail image of your clip.

 — Row 1: A main description field that is variable and determined by the sort order selection.

 — Row 2: Start Timecode, Date Created, Camera #.

 — Row 3: Scene, Shot, Take.

 — Row 4: Clip Name, Comment.
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The strength of the Metadata view is the automatic clustering of your 
clips in the Source Tape, based on the sort order you choose in the 
Media Pool Sort By menu at the very upper-right corner of the Media 
Pool. It is also possible to use these sort options in the Thumbnail, 
List, and Filmstrip views as well.

The Media  
Sort options

The Metadata View icon view (highlighted icon in the top bar), 
showing the thumbnail being scrubbed next to the clip’s metadata

The sort modes available in the Metadata view are:

 — Bin: This mode clusters the clips by bin, changes the main description field to clip name, and 
orders the list by timecode.

 — TImecode: This mode clusters the clips by creation date, changes the main description field to 
creation date and start timecode, and orders the list by timecode.

 — Camera: This mode clusters the clips by Camera #, changes the main description field to camera 
# and start timecode, and orders the list by timecode.

 — Date Time: This mode clusters the clips by day, changes the main description field to creation 
date and file name, and orders the list by timecode.

 — Clip Name: This mode clusters the clips by the first letter of the clip name in alphabetical order, 
changes the main description field to clip name, and orders the list by timecode.

 — Scene, Shot: This mode clusters the clips by scene, changes the main description field to scene-
shot-take, and orders the list by scene-shot-take.

 — Clip Color: This mode clusters the clips by clip color name, changes the main description field to 
creation date and start timecode, and orders the list by timecode.

 — Date Modified: This mode clusters the clips by day, changes the main description field to creation 
date and file name, and orders the list by the last time the clip was modified by the OS filesystem.

 — Date Imported: This mode clusters the clips by day, changes the main description field to 
creation date and file name, and orders the list by the date the clip was added to the Media Pool.

 — Ascending: Orders the Media Pool from lowest numerical value to highest, and 
alphabetically from A to Z.

 — Descending: Orders the Media Pool from highest numerical value to lowest, and 
alphabetically from Z to A.
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Each different sort mode changes the main description field on the card and re-arranges the Source 
Tape to reflect the selected organization method.

The Metadata view with clips sorted by Scene-Shot-Take

The Metadata view with the same clips sorted by Camera
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Thumbnail View 
Each clip is represented by a scrubbable thumbnail. Hover the playhead over each thumbnail and 
move it left and right to see the clip’s image play, and use the I and O keys to mark sections of a clip 
that you want to use. Hover scrub can be enabled and disabled using the Media Pool option menu on 
the Edit page.

The Icon View mode

Filmstrip View
Each clip is represented by a filmstrip of consecutive frames the length of the Media Pool. Hover the 
playhead over the clip and move it left and right to see the clip’s image play, and use the I and O keys 
to mark sections of a clip that you want to use.

The Filmstrip View mode
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List View
Each clip appears as an item in a multi-column list showing a variety of metadata about each clip. In 
list view, you can click the header of any column to sort the contents by that column’s information 
(clicking again toggles the sort order between Ascending and Descending). Scrolling right reveals 
additional columns of information.

The List View mode

Sorting and Searching
Once you’ve imported media into your project, searching and sorting controls help you find 
what you need.

Searching
A search field lets you type a term you want to use to find one or more clips that match that criteria. 
When you type anything, the contents of the Media Pool shrink to show only clips that match 
your criteria.

Navigable Clip Paths
The Media Pool in the Cut page has a navigable title bar that shows a clip’s Media Pool hierarchy. As 
you navigate in the Media Pool, the current clip is highlighted, and its hierarchy will now appear in 
top of the Media Pool title bar. By clicking directly on bins in this bin path, you can quickly broaden or 
narrow the scope of the Media Pool, say from Shoot Day to Camera to Card to Clip and vice versa.

The Media Pool title bar showing a clip’s Media Pool 
hierarchy. Clicking directly on these bins will narrow 
or broaden the scope of the clips in the Source tape.
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Sort Media By
A Sort Media By drop-down menu lets you choose which criteria defines the order in which clips in the 
Media Pool are arranged. Options include: Timecode, Camera, Date Time, Clip Name, Bin, Scene Shot, 
Clip Color, Date Modified, Date Imported, and Online Status, and you can choose to sort in Ascending 
(bottom to top) or Descending (top to bottom) order.

The Sort Media By drop-down menu

TIP: If you want to sort by a criteria that’s not in the drop-down menu, you can switch the 
Media Pool to List view, then sort by any column you might want (such as “Date Created”), 
and then switch back to Icon or Filmstrip view.

Finding Timeline Clips in the Media Pool
From time to time, you’ll find yourself wanting to find the source clip in the Media Pool that 
corresponds to a clip in the Timeline. For example, you might want to go back to a part of an interview 
clip you’ve already used to find another phrase on the same topic. 

To find a timeline clip in the Media Pool:

 — Right-click a clip in the Timeline, and choose Find in Media Pool from the contextual menu. 
The corresponding clip is selected in the Media Pool, which scrolls to show that clip, if necessary.
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Clip Color
Clip colors are an organizational tool that make it easier to keep track of different kinds of clips visually. 
For example, you can assign colors based on good takes, based on characters or subjects in the 
program, based on type of media (b-roll versus a-roll for example), or using any one of a number of 
organizational strategies. Whatever helps you keep track of things you need to keep track of.

Changing clip colors:

 — You can assign colors to clips by right-clicking one or more selected clips in the Media Pool 
or Timeline, and choosing one of 16 available colors from the Clip Color submenu of the 
contextual menu.

Removing clip colors:

 — Clip colors can be removed by right-clicking one or more selected clips in the Media Pool or 
Timeline, and choosing Clear Color from the Clip Color submenu of the contextual menu. 

 — Clip colors appear as a colored dot on a clip thumbnail when in Thumbnail view, as a clip color in 
Filmstrip view, and as a patch in the Clip Color column when in Column view. 

Clip color in – Thumbnail Clip color in – Filmstrip

Clip color in – Column views

 — Clips with assigned colors also appear tinted in the Timeline, similarly to the Filmstrip tint 
in the Media Pool.

A timeline with a video clip that has been 
colored to identify what they are to the editor 
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Generate Optimized Media
If you’re editing processor-intensive source formats such as camera raw, H.264, or 8K media, and 
your computer isn’t fast enough to work with it easily in real time, you can create pre-rendered, low-
overhead duplicate media to use instead, that’s automatically managed alongside the original media. 
This is called “Optimized Media.” Optimized Media lets you work more quickly by allowing you to edit 
with a more processor-efficient media format and resolution, while providing the ability to easily 
switch your project back to the original source media whenever you want. So, you can use optimized 
media to edit, and switch back to the original source media when it’s time to finish and output. 
Switching is as easy as choosing Playback > Use Optimized Media if Available to toggle optimized 
media on and off.

DaVinci Resolve automatically manages the relationship between source clips and the optimized 
media you create, so all you need to do is choose which clips to make optimized media for. 
For example, if you’re editing a project that consists of half camera raw media, and half DNxHD 
media, you only need to optimize the camera raw media, so you can use the search field to find 
all the raw clips you’ve imported based on Resolution, Codec, File Name, or whatever other 
metadata is appropriate.

To create optimized media:

1 Select one or more clips in the Media Pool that would benefit from being optimized.

2 Right-click one of the selected clips, and choose Generate Optimized Media from the 
contextual menu.

By default, all optimized media is written to the same directory as the cache files are written, which 
defaults to the first scratch disk listed in the Preference dialog’s Media Storage panel. The location of 
cache and optimized files is also selectable via the “Cache files location” setting in the Master Settings 
panel of the Project Settings.

Once you’ve created optimized media, all you need to do to use it is to choose Playback > Use 
Optimized Media if Available to toggle optimized media on and off.

For more information on choosing which format to optimize to, creating and managing optimized 
media, and how optimized media interacts with raw media, see Chapter 8, “Improving Performance, 
Proxies, and the Render Cache.”
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Relinking Media
DaVinci Resolve attempts to automatically keep track of the relationship between clips in your project 
and their corresponding source media on disk. If, for whatever reason, source media that links to clips 
in your project becomes unavailable because it’s been moved, DaVinci Resolve has several different 
methods of relinking those clips in the Media Pool. This section summarizes two methods of relinking, 
“Relink Media” and the “Relink selected clips” command. For more information on other methods of 
conforming projects and relinking media, see Chapter 56, “Conforming and Relinking Clips.”

Relink Media
If DaVinci Resolve fails to find your media, a Relink Media icon in the Cut page’s and Edit page’s Media 
Pools will highlight orange. 

The Relink Media icon that 
appears for unlinked media

Clicking this icon opens a dialog box showing the volumes that the missing files initially belonged 
to. You can then use this information to track down the media on your file system, find that 
specific hard drive, or ask a client if they provided you the media from this volume. Clicking the 
Locate button lets you re-connect the missing clips to a new file location of your choosing. If the 
quick search initiated by the Locate buttons doesn’t find media that you know is there, you can 
initialize an exhaustive deep disk search for the media by clicking on the Disk Search button.

The Relink Media dialog showing the volume 
names where the missing clips originated
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Relink Selected Clips
The appropriately named “Relink selected clips” command is the most flexible method of relinking 
clips in your project with clips in a directory of your choice, using file name and timecode as the 
primary criteria for reconnecting the relationship between each clip and its corresponding media 
file on disk.

To relink selected clips or clips in a selected bin:

1 Do one of the following:

 — Select one or more clips in the Media Pool browser that you want to relink, then right-
click one of the selected clips or the selected bin, and choose “Relink Selected Clips” from 
the contextual menu.

 — Select a bin in the Media Pool bin drop-down menu that contains clips you want to relink, 
then right-click the selected bin and choose “Relink Clips for Selected Bin” from the 
contextual menu.

2 When the Relink File dialog opens, choose a volume and directory in which to look for the files 
you want to relink to, and click OK. DaVinci Resolve attempts to find every clip with a matching 
file name in the subdirectories of the directory you chose, using the original file paths of the clips 
being relinked to do this as quickly as possible. By first looking for the clips in the directories they 
were originally in, relinking can be quite fast.

3 If there are any clips that couldn’t be found using the method in step 2, you’re prompted with 
the option to do a “deep search” by a second dialog. If you click Yes, then DaVinci Resolve will 
look for each clip inside every subdirectory of the directory you selected in step 2. This may take 
significantly longer, but it should be completely successful so long as the media that’s required is 
within the selected directory structure.

4 If there are still other clips that couldn’t be found, you’re prompted to either choose another 
directory altogether to continue searching, or quit.
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Chapter 28

Fast Editing in 
the Cut Page
The editing methods in the Cut page have been streamlined 
for fast editing, and the interface of this page and the methods 
of assembling clips together using different types of edits are 
designed to be easy to learn and quick to use.
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Creating and Modifying Timelines
After you’ve imported and organized the media you need to use in a program, the next thing you must 
do is create a timeline. Timelines are the organizational entities that contain the edited sequences of 
clips that make up your program. You can have as many timelines as you like in your project, with each 
timeline being an independent arrangement of clips. Timelines are stored in the Media Pool and can 
be organized using bins, just like clips.

Creating New Timelines
A timeline is automatically created when you edit your first clip into the Timeline. You’ll see an icon for 
the new timeline in the Media Pool, where you can rename it.

You can also create a new timeline by either choosing File > New Timeline (Command-N), or right-
clicking in the background of the Media Pool and choosing Create New Timeline. A dialog appears that 
lets you choose a start timecode (the default is 01:00:00:00), a name, how many video and audio tracks 
you want it to have, what kind of audio (the default is stereo), and whether or not you want to create 
an empty timeline, or a timeline that automatically includes all clips in the Media Pool with or without 
selected In/Out points (a quick and easy way of creating a stringout of all clips you’ve imported).

By default, all timelines share the same frame rate, resolution, and monitoring settings as the overall 
project. If you like, you can also click the Use Custom Settings button to choose individual frame rate, 
resolution, and monitoring settings for that timeline. 

Once you’ve created a new timeline, double-clicking it will open it into the Timeline Editor.

Opening Timelines
If you only have one timeline in your project, that timeline is always seen in the Timeline Editor. 
If you have multiple timelines, you can double-click any timeline in the Media Pool to open it into the 
Timeline Editor, ready for editing. You can also switch from working on one timeline to another by 
using the drop-down list at the top of the Cut page Viewer. This unifies Viewer Timeline Selection 
behavior across the Cut, Edit, Color, and Deliver pages.
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The Timeline Selection drop-down at 
the top of the Cut page Viewer

The Enlarge, Lock, Audio Enable, and Video 
Enable buttons in the header of a timeline track

About Tracks in the Cut Page Timeline
Tracks in the Cut page timeline combine a clip’s audio and video into a single track for convenience, 
as this makes it easy to keep audio and video organized and in sync when superimposing many 
clips together. This means that tracks have both video and audio enable controls in the track header 
controls, so that you can selectively disable video and mute audio when necessary.

Each track also has a lock control, which lets you prevent clips on that track from being 
altered in any way.

Enlarging Tracks
Track size can be enlarged and minimized by clicking on the Track Sizing icon on the left side of the 
track header. An expanded video track shows a full size video and audio track, if attached. This makes 
it easier to see just the track you want to focus on. Only one track can be expanded at a time.

Clicking on the Track Sizing icon expands the track to show the full audio track of the clip

Adding Tracks
If your timeline doesn’t have enough tracks, you can click on the Timeline Actions menu and select 
Add Video/Audio/Subtitle track, or right-click anywhere in the Timeline and choose “Add Track,” and a 
new track will be added on top of the previously existing tracks.

TIP: Dragging a new clip to the undefined gray area at the top of the Timeline also 
adds a new track.
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Deleting Tracks
If you want to delete a specific track along with all clips on that track, you can right-click anywhere in 
that track’s header and choose “Delete Track.”

If your timeline has too many empty tracks, you can right-click anywhere in the track header and 
choose “Delete Empty Tracks” and all empty tracks will be removed.

Navigating Clips in the 
Viewer and Timeline
Before you can start editing, you need to find which parts of which clips you want to use, and define 
where in the currently open timeline you want to make an edit. The Single Viewer in the Cut page has 
three options that let you choose what media you want to play through using the transport controls 
found at the bottom.

Viewer Options
Three options, selectable via buttons at the upper left of the Viewer, let you control what the 
Viewer shows.

The Viewer option buttons, (left to right) Source 
Clip, Source Tape, Timeline, and Safe Area

 — Source Clip: This option shows the currently selected clip in the Media Pool. This is the mode the 
Viewer automatically switches to whenever you double-click a clip in the Media Pool. In Source 
Clip, a scroll area appears at the bottom of the Viewer, the width of which represents the duration 
of the currently open clip. A playhead within the scroll area lets you scrub through the clip as a 
zoomed-in waveform and shows whatever audio is playing within the clip. Handles to the left and 
right of the scroll area let you reposition In and Out points within the clip to choose a section you 
want to edit into the Timeline. These In and Out points can also be set using the I and O keys. 
Once set, you can drag In and Out points to change them.

The scroll area in Source Clip option, with In and Out points positioned to either side of the playhead

 — Source Tape: Using this option, every single clip in the currently open bin, and any subfolders in 
that bin, of the Media Pool is shown in the Viewer as a “stringout” in the scroll area at the bottom 
of the Viewer. In the scroll area, each clip appears one after the other in a long strip, with the 
order determined by the Sort order. This makes it easy to scrub through a whole collection of clips 
while you’re figuring out what you want to use. As you play through, whichever clip the playhead 
intersects is selected in the Media Pool, so you know which clip you’re looking at.
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The scroll area in the Source Tape, with each clip separated by a thin line

 — Timeline: This option shows the current frame at the position of the playhead in the Timeline. 
Whenever you click, drag, or adjust a clip in the timeline area, the Viewer switches to the 
Timeline. In this option there is no scroll area; you must use the timeline area to scrub through 
your program. However, in the space where the scroll area would otherwise be, icons appear to 
indicate when the playhead is positioned at the first or last frame of a clip in the Timeline.

The scroll area in the Timeline option shows icons to indicate the beginning and end of clips

 — Safe Area: This drop-down menu overlays many useful framing guides over the Viewer to let you 
see what part of the image will be included and what will part will be cropped out if you change 
the Timeline’s aspect ratio. The framing guides can be turned on and off by toggling the Safe Area 
Framing Guide icon in the Viewer, and the exact guides can be selected in the drop-down menu.

 — Social Media: 1:1, 4:5, 9:16, 1.91:1, 16:9.

 — Broadcast and Film: 1.33, 1.66, 1.77, 1.85, 2.35.

 — Safe Area Guides: These options add additional guide lines on the Viewer to protect your 
composition from possibly being cut off at the extreme edges of a physical cathode ray 
tube. While somewhat anachronistic in this age of flat screen digital televisions, many legacy 
programs still adhere to these guidelines. Safe Areas still can be useful guides in ensuring 
your image is not inadvertently cropped by the variety of mobile devices and social media 
sites in use today.

Action Keep all movement and important action within this box.

Title Keep all on screen text within this box.

Center Designates the exact middle of the image.

The Safe Area Framing Guide icon (circled) 
and the possible framing options
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Full Screen Viewer
The Cut page has a Full Screen Viewer icon in the upper-right that can be clicked to enable Full Screen 
view. Press Escape to return to your normal view mode.

The Full Screen Viewer icon

Proxy Handling
You can switch between using your original source media and the proxy media for playback in the 
Cut page by using the Proxy Handling icon in the Viewer, and selecting one of the following options:

 — Disable All Proxies: This option disables the proxies altogether and forces the original 
media playback only. If the original media is not available, the clip is replaced with a Media 
Offline graphic. 

 — Prefer Proxies: This option will use proxies files for playback, and if there is no proxy file for a clip, 
the original media will automatically be used instead.

 — Prefer Camera Originals: This option will use the original media files for playback, and if there is 
no original media file for a clip, the proxy media will automatically be used instead.

The Proxy Handling icon in the Cut page Viewer 
lets you select how you want to use proxy files.

Playing Clips and Navigating 
the Timeline in the Viewer
Eight controls sit at the bottom of the Viewer. These let you play through and otherwise navigate clips 
and the Timeline in different ways. These controls are described from left to right.

The toolbar at the bottom of the Viewer

 — Fast Review button: Intended to help you watch through a large collection of media quickly, 
clicking this button begins accelerated playback through the Source Tape or through the Timeline, 
where the speed of playback is relative to the length of each clip you’re playing through. Long 
clips play faster, whereas shorter clips play closer to real time. In this way, you can watch a lot of 
material really quickly.

 — Tools button: The Tools button reveals a variety of controls for transform, crop, audio, speed 
effects, camera stabilization and lens correction, dynamic zoom, and compositing, covered in 
more detail later in this chapter.

 — Jog control: Clicking and dragging within the jog control lets you scrub very precisely through the 
content of the Viewer.
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 — Transport controls: A set of buttons provide clickable controls to control playback of source clips 
and the Timeline, whichever the Viewer is set to display; each button has a matching keyboard 
shortcut. These include Previous Edit (Up Arrow), Stop (Spacebar), Play (Spacebar), Next Edit 
(Down Arrow), and Loop Playback (Command /).

 — Mark In/Out: Clickable controls to set In and Out points respectively.

 — Playhead timecode: A number field shows you the timecode value at the playhead of a clip or 
of the Timeline, to give you a numeric reference for where you are. There is also a dedicated 
timecode entry mode for the Cut page. There are three ways of telling DaVinci Resolve that you 
want to perform a timecode action, regardless of what the numeric keypad keys are assigned to in 
the Keyboard Customization preferences.

 — Select Playback > Goto > Timecode (=) and enter your timecode value.

 — Press “+” or “-“ keys, and enter your timecode value to move the current position 
forward or backward by that amount.

 — Click on the Timeline Timecode display on the Viewer, and enter your timecode value.

Scrolling Through the Timeline
The playhead in the Cut page is fixed. When you play, shuttle, or jog through your program, the clips 
in the Timeline flow past the playhead from right to left if you’re playing forward, or from left to right 
if you’re playing backward. This means that for playback, editing, or trimming, you bring the frame you 
want to see to the playhead, rather than bringing the playhead to the frame (as you do on the Edit page).

To scroll or scrub through the Timeline, do one of the following:

 — Set the Viewer to show the Timeline, then use any transport or playback controls or keyboard 
shortcuts to move the clips in the Timeline back and forth, with the playhead indicating the 
current frame.

 — Position the pointer within the Timeline Ruler of the Upper Timeline, and drag to the left or right 
to scrub through your entire program.

 — Position the pointer within the Timeline Ruler of the larger Timeline Editor below, and drag to the 
left or right to scrub through the immediate vicinity of the current frame.

 — You can use the navigation tools Playback > Previous / Next > Clip (Up Arrow/Down Arrow) or 
Marker (Shift - Up Arrow/Shift - Down Arrow) to navigate the Cut page Timelines.

TIP: If at any time you need to analyze the video in the Viewer, DaVinci Resolve’s full 
set of scopes is available in the Cut page by selecting Workspace > Video Scopes > On 
(Shift-Command-W).

Display Clip Names and Status in the Timeline
If you wish, you can see clip names and clip status icons directly on your clips in the Timeline, for easier 
identification.
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To Display Clip Names for Clips in the Cut Timeline:

 — Click on the Timeline Options icon.

 — Select Display Clip Names from the drop-down menu.

To Display Clip Status Icons for Clips in the Cut Timeline:

 — Click on the Timeline Options icon.

 — Select Display Clip Status from the drop-down menu.

Scene Cut Detection in the Cut Timeline  
(Studio Version Only)
You can use the Scene Cut functionality directly in a Cut timeline. This is useful if you’ve imported 
video files of an already edited program, and you wish to automatically cut it back up into individual 
clips. For more information on using Scene Cut Detection, see Chapter 23, “Using Scene Detection.”

To use Scene Cut Detection on a Cut Page Timeline:

1 Select the video clips you want to split back into multiple cuts on the Timeline.

2 Select the Timeline Actions icon and choose Detect Scene Cuts from the drop-down menu.

The Boring Detector
The Boring Detector performs a live analysis of the lengths of each of your clips on the Timeline and 
then highlights areas that are too long or too short and may demand your attention. It’s accessed by 
clicking the Timeline Options icon and selecting Boring Detector. It can be toggled off by clicking the 
icon again.

The Boring Detector icon and the Timeline showing its results

Analyze Timeline Edits
The Boring Detector’s parameters are modifiable in its Analyze Timeline Edits window.

 — Boring Clips: By adjusting this slider, you can set the minimum number of seconds that a clip’s 
duration has to be before being flagged as too long. Clips that exceed this length are highlighted 
in light gray on the Upper Timeline.

 — Jump Cuts: Adjusting this slider sets the maximum number of frames that a clip’s duration has 
to be before being flagged as too short. Clips that are shorter than this length are highlighted 
in red on the Upper Timeline. Setting this to 2 frames can help you automatically find accidental 
“flash frames.”

 — Cancel: Closes the window without making any changes to the Boring Detector’s analysis.
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 — Analyze: Starts the live analysis of your timeline using the criteria you’ve selected above. 
The Boring Detecter is persistent and continues to function as you make further edits in 
the Cut page. It can be turned off by clicking the Boring Detector icon again.

The Boring Detector’s Analyze 
Timeline Edits window

Setting In and Out Points
Ordinarily, source media is much longer than the actual clips you’ll be using in a program, so it’s 
important to be able to define a range of media you want to edit into the Timeline. This is done by 
setting In and Out points, either in the Media Pool in Thumbnail or Filmstrip mode, or in the Viewer in 
Source Clip or the Source Tape.

Setting In and Out Points Using the Keyboard
When scrubbing through a thumbnail or filmstrip in the Media Pool, you can press the I (In) or O (Out) 
keys to define a range of media. The edit points appear superimposed over the thumbnail area of the 
clip, as well as the scroll area of the Viewer if the clip is being mirrored there.

Defining a range of media in the Media Pool 
using In and Out points (in white)

When scrubbing or shuttling through media in the Viewer in Source Clip or the Source Tape, or 
through your program with the Viewer in Timeline mode, you can press the I (In) or O (Out) keys to 
define a range of media. 
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Defining a range of media in the Viewer using In and Out points

When scrubbing or shuttling through the Timeline as you drag the ruler to the left and right, you can 
press the I (In) or O (Out) keys to define a range for incoming edit operations. The range is marked in 
both the upper and lower areas of the Timeline.

Defining a range of the Timeline for editing operations using In and Out points

Setting In and Out Points Using the Pointer
If you’re using a pointing device such as a mouse, trackpad or tablet, you can drag the In and Out 
handles found underneath the scroll area at the bottom of the Viewer to define a range of media.

The draggable In and Out controls at the bottom of the Viewer

Once you’ve set In and Out points, the jog In and Out controls, located at the far left and right of the 
scroll area in the Viewer, let you fine-tune the location of the In and Out points. Click and drag on the 
Jog In or Jog Out controls to move either edit point in precise increments. While you drag, a filmstrip 
above shows you how many frames you’re trimming.

The draggable Jog In control being used to trim the In point
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In and Out points set in the Timeline Ruler (either of the Upper Timeline or the Timeline Editor) can be 
dragged to the left or right to fine-tune them.

The draggable In and Out points 
in the Timeline Ruler

Editing the Duration Field in the Cut Page Viewer
When editing in the Cut page, you set In and Out points to insert a specified range of video. The 
duration of that video range appears in the Duration field, which is in the upper-right corner of 
the Viewer.

This field is now editable, and updates the Out point to match the value you enter. You can directly 
enter a certain number of frames, use the + or - modifiers to change the value by that exact amount, 
or make adjustments to the hh:mm:ss:ff field directly.

The editable duration field in 
the top right of the Viewer

Change Clip Duration Dialog
The Change Clip Duration dialog allows you to directly change the duration of a clip by typing in 
frames, a timecode value, or using time and frame-based presets. You can activate the Change Clip 
Duration dialog by selecting one or more clips on the Timeline and choosing Clip > Change Clip 
Duration (Command-D), or by right-clicking on a clip and choosing Change Clip Duration from the 
contextual menu. The Change Clip Duration dialog works both on the Cut and Edit pages. 

The new Change Clip Duration 
box in Timecode mode.
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Options for the Change Clip Duration Dialog box:

 — Format: You can chose between working with Time (Timecode) or Frame values.

 — Duration: Type in the timecode value or number of frames you wish to make the new duration of 
the selected clip.

 — Preset: Select a duration by clicking on 1, 5, or 15 seconds (or their equivalent value in frames). 
End will extend the duration to the last frame of the selected clip, regardless of any Out points set.

 — Extend Beyond Clip Length (Cut page only): This will append black filler to any clip whose 
duration is set longer than the clip itself.

 — Cancel/Change: Click Cancel to to exit without changing the duration of the clip, or Change to 
apply the duration change to the selected clip.

TIP: You can change the duration for more than one clip at a time by selecting multiple 
clips before opening Change Clip Duration. All clips selected will be the changed to the 
same duration set in the Change Clip Duration dialog box. 

Video Only and Audio Only Edits
Normally, any edit function in the Cut page uses both the Audio and Video sections of a clip to insert 
into the Timeline. However, there are several scenarios where you would only want either the Audio or 
the Video portions to be used instead.

To perform an Audio Only edit:

 — Select the Audio Only icon to the left of the Upper Timeline, deselect to return to the normal audio 
and video edit.

To perform a Video Only edit:

 — Select the Video Only icon to the left of the Upper Timeline, deselect to return to the normal audio 
and video edit.

(Left) The Audio Only icon, (Right) The Video Only icon

Drag and Drop Editing
Drag and drop editing can be an easy way of assembling clips into a loose edit. Once you’ve defined 
a range of media using the Source Clip or the Source Tape, you can click and drag either from the 
Viewer or the Media Pool to the Upper Timeline or the Timeline below to edit a clip into your program. 
How and where you drag determines how that clip will be edited.
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Append
If you drag a clip onto an empty timeline, or to the dark gray area to the left of clips in the Timeline, 
that clip will become the first clip of your edit. If you drag a clip to the far left or right edge of all other 
clips in the upper or lower areas of the Timeline, you will append that clip to the ending or beginning 
of the Timeline.

(Top) Dragging a clip to the 
far right of the Timeline 
to append it, (Bottom) 
The appended clip

Ripple Overwrite
If you drag a clip onto a pre-existing clip in either the Timeline or Upper Timeline so that the entire 
clip highlights and you drop it immediately, you’ll perform a Ripple Overwrite edit, substituting the 
previous clip in the Timeline with the new clip. If you’ve ripple overwritten a clip on Track 1, all clips 
to the right of it will be rippled to make room if the incoming clip is longer, or close the gap if the 
incoming clip is shorter.

(Top) Dragging clip 
DD onto clip BB on 
the Timeline to Ripple 
Overwrite clip BB, 
(Bottom) Clip DD is shorter 
than clip BB, so the 
Timeline becomes shorter 
once the edit is done

Overwrite
If you drag a clip onto a pre-existing clip in either the Timeline or Upper Timeline and wait a moment, 
the Timeline overlay changes from a highlight over the whole clip to a highlight showing just the 
portion of the incoming clip overlaid on the existing clip. When you drop the clip, you’ll perform 
an Overwrite edit, which writes over the media that’s already in the Timeline with the media of the 
incoming clip. Overwrite edits don’t ripple the Timeline.
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(Top) Dragging clip 
DD onto clip BB on the 
Timeline and pausing to 
perform an Overwrite, 
(Bottom) Clip DD 
overwrites the middle 
of clip BB, breaking it 
into two pieces while 
the Timeline remains 
the same duration

Using Cut Page Edit Commands
At the bottom of the Media Pool is a set of five buttons that let you make other kinds of edits. Some of 
these edits have keyboard shortcuts assigned to them and are also available via dedicated keys on the 
DaVinci Resolve Editor Keyboard.

Smart Indicator showing 
where an edit will occur

The edit buttons underneath the Media Pool, (Left to Right) Smart Insert, 
Append, Ripple Overwrite, Close Up, Place On Top, Source Overwrite

Smart Indicators
Some of the intelligent tools in the Cut page do not require you to select specific In and Out points in 
the Timeline; they rely on the playhead’s relative position over a clip to guess where you likely will want 
to make your edit. The point where DaVinci Resolve intends to make that edit is marked using a Smart 
Indicator icon on the Timeline Ruler. To make the edit points easier to identify on the Timeline, after 
a few seconds, the Smart Indicator will move up and down on the Timeline ruler, while the actual edit 
point will strobe green (red if the clip has reached its start or end frame).
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Setting Up and Performing Edits
No matter what kind of edit you intend to make, the process of setting them up and performing 
them is the same. This section describes the general process of setting up an edit, and the following 
sections will describe how each particular edit works.

To set up and perform an edit:

1 First, locate a clip you want to edit into the Timeline. There are two general ways of doing this:

a) Open a bin with clips you want to use, then click the Source Tape in the Viewer to show a 
stringout of all clips in the current bin, and its subfolders, in the currently selected sort order. 
Now, you can scrub around all these clips using JKL or the DaVinci Speed Editor’s shuttle/jog/
scroll wheel to find the media you’re looking for.

b) Open a bin with clips you want to use, and navigate the thumbnails, filmstrips, or columns to 
select the clip you want, using the Search field if necessary to help find the clip you’re looking for. 

2 Scrub a thumbnail or filmstrip, or use the controls in the Viewer, or use the controls of your 
DaVinci Speed Editor to locate frames at which you want to set In and Out points to define an edit 
range, and use the I (In) and O (Out) keys to set those points.

3 If necessary, choose which video track you want to edit to by clicking in its track header to select it. 
Selected tracks are highlighted.

4 Perform an edit to put the selected range of the source clip into the selected video track at the 
desired frame, using either the buttons at the bottom of the Media Pool, or keyboard shortcuts. 
Different edit commands will put the source clip into different locations.

5 After you’ve committed your edit, you can press Q (or click the Timeline Viewer button) to switch 
the Viewer to the Timeline to play and review the edit you’ve just made, and then press Q again to 
switch back to the Source Clip or Source Tape (whichever was last used) to locate the next clip you 
want to edit, starting all over again at Step 1.

Smart Insert
Automatically inserts an incoming clip at the closest edit point to the playhead (as shown by the Smart 
Indicator) on the selected track, pushing all clips to the right of the edit point forward to make room 
for the incoming clip if you’ve inserted to Track 1. Because this is a smart operation, you are prevented 
from inserting a clip at any arbitrary frame; incoming clips are only inserted at the closest previously 
existing edit point.

(Top) Before doing a 
Smart Insert, (Bottom) 
After inserting clip DD 
between clips AA and BB
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Append
The position of the playhead is ignored; incoming clips are always placed after the last 
clip in the Timeline.

Performing an 
Append edit of clip 
DD to the Timeline

Ripple Overwrite
At its simplest, Ripple Overwrite substitutes a clip in the Timeline with an incoming clip. If you use 
Ripple Overwrite on a clip on Track 1, this will automatically move all clips that are to the right of the 
affected clip in the Timeline either forward to make room if the incoming clip is longer, or back to 
eliminate gaps if the incoming clip is shorter. 

Performing a Ripple 
Overwrite to substitute 
an entire clip at the 
playhead (BB) with the 
incoming clip (DD)

However, Ripple Overwrite works differently if you’ve set In and Out points in the Timeline to define 
a range. In this case, the incoming clip substitutes whatever portion of the Timeline falls within this 
range, moving all other clips that are to the right of the affected range either forward to make room if 
the incoming clip is longer, or back to eliminate gaps if the incoming clip is shorter.
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Performing a 
Ripple Overwrite 
to substitute a In/
Out range of the 
Timeline (part of 
clips BB and CC) with 
the incoming clip DD

Close Up
Lets you edit a clip into the Timeline as a zoomed-in close up, to make up for a lack of actual close ups 
that would have been shot with either longer lenses or by moving the camera closer to the subject. 
This function is particularly useful when you’re working with 4K media in a 1080 timeline, or 8K media 
in a 4K timeline, which enables you zoom into existing wide shots to create medium shots, or medium 
shots to create close up shots, with no loss of quality. 

Performing this edit adds the incoming clip as an approximate 150% scaled close up, also performs a 
face detection, and if a face or faces are found, automatically re-positions the face in the frame. Which 
frame of the Timeline the incoming clip aligns with depends on the following:

 — If no In or Out points are set on the Timeline, the incoming clip aligns with the Timeline playhead 
as the In point.

 — The incoming clip aligns with a timeline In point if one has been set.

 — The incoming clip’s Out point will align with a timeline Out point if one has been set without an In 
point. This “backtimes” the clip.

(Top) Before a Close 
Up edit, (Bottom) 
After editing clip DD  
into the Timeline 
with a Close Up edit

Place On Top
Lets you edit the incoming clip as a superimposition above whatever other clips are in the Timeline; 
the incoming clip is always placed on top, so if there are clips in tracks 1, 2, and 3, the incoming clip 
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is automatically placed on track 4, regardless of which track is selected. The frame the incoming clip 
aligns with depends on the following:

 — When the playhead is near an edit point (within five frames), the incoming clip aligns with the 
closest timeline edit point in proximity to the playhead (as shown by the Smart Indicator) if no 
timeline In or Out points have been defined.

 — When the playhead is not near an edit point, the incoming clip aligns with the playhead if no 
timeline In or Out points have been defined.

 — The incoming clip aligns with a timeline In point if one has been set.

 — The incoming clip’s Out point will align with a timeline Out point if one has been set without an In 
point. This “backtimes” the clip.

(Top) Before placing a 
clip on top, (Bottom) 
After editing clip DD  
into the timeline with 
a Place On Top edit

Source Overwrite
This edit requires overlapping timecode in multiple clips to work properly, such as when recording 
synced timecode to multiple cameras during a multi-cam shoot. If there is no overlapping timecode, 
this edit does nothing.

If you are working with footage from multiple cameras that have synced timecode, then the easiest 
way to use this edit type is to set In and Out points over a clip in the Timeline where you want to cut 
away to another angle. In the following example, a wide shot of a cooking show covers the moment 
when the chef starts slicing a chili.

Setting Timeline In and Out points to identify a cutaway

You can then select a clip in the Media Pool that corresponds to the desired angle you want to add as 
a cutaway, that has synced timecode that overlaps with the clip in the Timeline. Don’t set In and Out 
points; if necessary you can clear previously set In and Out points by pressing Option-X.
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Choosing a Media Pool clip from another camera that has overlapping timecode

When you click the Source Overwrite button, a synced section of the selected Media Pool clip will be 
edited into the Timeline between the In and Out points you placed, superimposed on top. The result is 
a perfectly timed cutaway.

Using Source Overwrite to edit a superimposed and synced section of 
the source clip into the Timeline between the In/Out points

Alternatively, you can also use Source Overwrite to automatically place a source clip with a marked In/
Out region on top of a clip in the Timeline so that its timecode syncs with the timecode of the timeline 
clip, when you don’t know exactly how much of the incoming source clip you want to edit into the 
Timeline, and you just want it synced appropriately.

Overwrite
While there’s no button available for performing an overwrite edit, you can use the F10 key to perform 
an overwrite edit, which overwrites a section of the Timeline with the incoming clip, without moving 
other clips in any way. The frame the incoming clip aligns with depends on the following:

 — The incoming clip aligns with the playhead if no timeline In or Out points have been defined.

 — The incoming clip aligns with a timeline In point if one has been set.

 — The incoming clip’s Out point will align with a timeline Out point if one has been set without an 
In point. This “backtimes” the clip.
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(Top) Before, 
positioning the 
playhead at the 
frame you want to 
use as the In point 
for the incoming 
clip, (Bottom) After 
overwriting the 
end of clip CC with 
incoming clip DD

Subtitles
Subtitles in the Cut Timeline
The Cut page now has the same subtitle support as the Edit page, including the automatic Create 
Subtitles from Audio feature. For more information on how to use subtitles, see Chapter 52, “Subtitles 
and Closed Captioning.”

To Add a Subtitle Track in the Cut Timeline:

 — Click on the Timeline Actions icon.

 — Select Add Subtitle Track from the drop-down menu.

Subtitle Tracks can be minimized in the Cut page to give more room for Audio and Video tracks by 
clicking on the Timeline Options icon, and selecting Minimize Subtitle Track.

Create Subtitles from Audio  
(Studio Version Only)
You can automatically create subtitles from your timeline’s audio tracks by using the DaVinci Resolve 
Neural engine to analyze the speech, and automatically turn it into text subtitles. For more information 
on automatic subtitling, see Chapter 52, “Subtitles and Closed Captioning.”

To Automatically Detect and Create Captions from Timeline Audio:

 — Open the timeline with the video and audio clips you want to caption.

 — Select the Timeline Actions icon and choose Create Subtitles from Audio from the drop-down menu.

Source Tape Editing
While all the features of the Cut page can be used individually, certain features are designed to be 
used in conjunction with each other to make your editing experience more streamlined. For example, 
combining the File Inspector, Source Tape, Metadata View, and the Navigable Folder Structure can 
create a well structured and organized project out of a single folder of unorganized clips.
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Metadata Entry Using the File Inspector
The first step in organizing any project is metadata entry. In our initial project we have a large amount 
of clips all residing in a single Master Bin. We need to add appropriate metadata to these clips, and to 
do this we will be using the File Inspector.

An unorganized Media Pool in the Cut page

After the File Inspector is open, check the box Auto Select Next Unsorted Clip, and this will automatically 
select the same metadata field in the next clip in the Media Pool, after you hit the return key. Enter in 
the Scene, Shot, and Take metadata for each clip, based on the information on the slate in each clip. 

Once each clip has its scene, shot, and take metadata, select all the clips in the Media Pool, then enter 
the text string “%{Scene}_%{Shot}_%{Take}” in the Name field of the File Inspector. These variables will 
replace the clip names for all clips with their scene shot and take numbers separated by underscores, 
for example: “02A_CU_03”.

Entering Scene, Shot, and Take metadata in the File Inspector, and renaming all clips via variables

528The Cut Page | Chapter 28 Fast Editing in the Cut Page



Now make two new bins in the Media Pool, Scene01 and Scene02, and drag all the clips that start with 
the name 01 into the Scene01 folder, and all the clips that start with the name 02 into the Scene02 
folder. Our metadata entry for this project is now done.

The Media Pool with 
all scene 1 clips in 
the Scene01 folder, 
and scene 2 clips in 
the Scene02 folder

Using the Source Tape
Now turn on the Source Tape, by clicking on its icon in the Viewer. Select Metadata View from the Media 
Pool view options, and then Sort By Scene, Shot in the Sort menu. You will now see the clips clustered 
by scene in the Media Pool, and all clips from both scenes are laid out in scene order in the Source Tape 
viewer. Selecting a specific clip in the Media Pool will snap the playhead to the first frame of that clip in 
the Source Tape. From here you can easily see the progression of the shots (take two follows take one, 
etc.), and continue your editing from here without having to hunt and click in the Media Pool.

The Source Tape reflecting all clips in the Media Pool, and the 
Metadata View showing the clips clustered by Scene

Limiting the Source Tape Scope by Folder Structure
As your project grows, it can become unwieldy to constantly have an entire film’s worth of media in 
the Source Tape. It is possible to limit the scope of the Source Tape at the bin level. As you navigate in 
the Source Tape, the current clip is highlighted, and its hierarchy will now appear in top of the Media 
Pool title bar. By clicking directly on bins in this bin path, you can quickly broaden or narrow the scope 
of the Source Tape. If you click on Scene02, the Source Tape will then zoom in to only show you clips in 
that folder. Clicking back on Master will zoom out the Source Tape to show the clips in all folders again. 

The navigable folder 
structure; clicking on these 
levels will narrow or broaden 
the scope of the Source Tape.
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The Source Tape limited to showing only clips from Scene02

The Source Tape limited to showing only clips from Scene01

The Source Tape broadened to showing all clips in the Master folder

This is also useful when navigating bin structures that reflect the original camera file system. For 
example, you may have a camera that records each memory card as a separate folder, and then each 
individual clip is saved as a separate folder inside that folder. When you bring this file system into 
the Media Pool using the Create Bins option, these nested levels are mirrored in the Media Pool bin 
structure. Now when you click on a card bin in the Source tape, it will directly show you all the clips on 
that card, rather than show many individual sub-bins. This view is also viewable in Thumbnail, List, and 
Filmstrip views.
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Sync Bin Multicam Editing
DaVinci Resolve has a number of tools to make editing multi-camera productions more intuitive 
and efficient. If simultaneously recorded clips from different cameras share common timecode, 
DaVinci Resolve can automatically sync all of these different camera angles together as you edit. 
The tools described in this section act as a sort of digital assistant editor that is constantly searching 
through all your media, and presenting all of the relevant shots to you at the exactly the right time. 
This functionality, combined with the DaVinci Resolve Speed Editor, makes the Cut page an extremely 
powerful multi-camera editor.

Preparing Footage for Sync Bin Editing
In order to properly work with the Sync Bin, every clip in that bin must have the following 
characteristics.

All Clips Must Have a Common Timecode
Professional video cameras and audio recorders generally have the ability to “jam-sync” their 
timecodes together so that each separate video and audio source records the exact same timecode 
at the exact same time. Jam-syncing timecode is the quickest, easiest, and most reliable method to 
ensure your footage syncs perfectly.

If your footage does not have a common timecode, you will need to go through some extra steps to 
ensure that all your material matches up at the correct time. For more information, see the Sync Clips 
Window section below.

All Clips Must Have a Unique Camera Name
Most professional video cameras will have some sort of mechanism for naming the camera in its 
internal menu system. This camera name is then recorded as metadata in each captured clip, which 
can be read automatically by DaVinci Resolve. Cameras should be named either alphabetically (A, B, 
C, etc.), or numerically (1, 2, 3, etc.), and in a sequential order totaling the number of cameras that you 
are recording with.

If your camera does not automatically record this information (or it’s set incorrectly), you can manually 
set the camera’s name by modifying the Camera # field in the Metadata Editor in the Media Pool.

Sync Clips Window
If your footage does not share common timecode, or if the existing timecode needs to be modified 
for any reason, the Media Pool in the Cut page offers a Sync Clips window that allows you to modify 
the sync of all clips in a bin. It is accessed by clicking on the Sync Clips Window icon on top of the 
Media Pool.

The Media 
Pool Sync Clips 
window icon

531The Cut Page | Chapter 28 Fast Editing in the Cut Page



The Sync Clips window opens and shows a live multi-camera sync Viewer on the left, and a standard 
clip Viewer on the right. There is also a timeline below that shows the temporal relationship of all the 
clips in the bin.

The Media Pool Sync Clips window

Sync By Tools
DaVinci Resolve offers several tools to automatically align your shots into perfect sync.

 — Timecode: This button will try to align all the clips in the Sync Clips window by timecode; this is the 
default option.

 — Audio: This button will try to align all the clips in the Sync Clips window by analyzing the audio 
tracks of each clip. In order for this to work, each clip must have at least a portion of the same 
audio track recorded clearly enough to analyze. An error message will notify you of which tracks 
could not be synced by this method.

 — In Point: This button will try to align all the clips in the Sync Clips window by their user set In point. 
This is useful if you have a common mark that was shot across all cameras, for example a slate that 
claps closed, or a camera flash.

 — Out Point: This button will try to align all the clips in the Sync Clips window by their user set 
Out point. This is useful if there was a common tail slate.

 — Sync: This button will execute the Sync By method selected above.

Once all of the clips in the window are synced appropriately, hit the Save Sync button in the lower 
right-hand side of the window.

s

The Media Pool Sync By icons (L-R: Timecode, Audio, In point, Out point)
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Manually Syncing Clips in the Sync Clips Window
If none of the Sync By tools is appropriate for the clips in your bin, you can manually sync the clips 
together by dragging each clip to the appropriate position on the Sync Clips Window timeline. 
For finer control, select the clip you want to sync and press the Comma (,) or Period (.) keys to nudge 
the clip backward or forward by one frame. Shift-Comma (,) or Shift-Period (.) nudges the clip by 
5 frames (default), or by the amount of frames set in the “Default fast nudge length” setting in the 
General Settings section of the Editing panel in the User settings of the Resolve Preferences. Each clip 
has its own track, and you can enable sync lock in the right-hand Viewer to prevent accidental slipping.

Once all of the clips in the window are synced appropriately, click the Save Sync button in the lower 
right-hand corner of the window.

Using Your Newly Synced Clips
After saving the sync on your clips, a new Multicam clip will appear in the Media Pool. If you select the 
Thumbnail View, a Sync icon appears on all the clips you modified. If you want to modify your sync, 
right-click on a thumbnail and select Open Sync Group to reopen your clips in the Sync Clips window. 
Once you place your first clip on the Timeline as a reference, you are now ready to use the Sync 
Bin to edit.

Sync icons (upper left arrows) identifying synced media clips

Sync Bin Editing
The core idea behind the Sync Bin layout is that instead of traditionally scrubbing through your 
timeline and clips independently, you now only have to scrub through your timeline. In the Media 
Pool, all of the clips that exist with that same timecode value will automatically scrub in sync with the 
playhead. This allows you to always have the exact clips that will fit perfectly in your timeline available 
at your fingertips.

Selecting this mode automatically changes the layout of the Media Pool and the Viewer to better 
accommodate multi camera editing in the Cut page.

Edit in Your First Clip from the Media Pool
Choose a clip that will be your base layer and place it on Track 1. This clip is used as the reference for 
all of the other clips in the Sync Bin. Then press the Sync Bin icon.

The Sync Bin icon

533The Cut Page | Chapter 28 Fast Editing in the Cut Page



Media Pool in the Sync Bin
All of the clips in the bin, and its subfolders, are presented in filmstrip mode. The clips are ganged 
together automatically by timecode and sorted by camera number. An additional playhead appears 
at the current timeline position, and moving any of the three playheads in the Cut page will scrub 
through all of the clips in the Sync Bin at the same time.

Viewer in the Sync Bin
The Viewer switches to a live Multi Viewer for up to nine cameras. Each camera is labeled, numbered, 
and the active camera in the Timeline is highlighted in red. Cameras that were not active at the current 
playhead time are blacked out. 

The Sync Bin camera selection can be viewed full screen in the Cinema Viewer by pressing “P” on your 
keyboard, allowing you to see a larger, more detailed view of each specific camera. In this full-screen 
mode, the Sync Bin view controls operate identically to those in the normal Viewer.

The Media Pool and Viewer in Sync Bin view

Select Your Timeline In Point 
Select the In point on your timeline by scrubbing the timeline playhead to the position you wish 
your media to start. As you do this, all of the clips in the Sync Bin will scrub along with the playhead 
position. Finding and selecting your edit points in the Sync Bin is greatly simplified, as all of your 
possible synced media choices are available instantly.

When the “Video Only” mode is activated in the Cut page, audio from the sources in the Sync Bin are 
now muted, and the audio playback is from the clips in the Timeline only.

Select Your Camera
In the Multicam Viewer, select the camera angle you wish to use as your source material by doing one 
of the following:

 — Clicking on the appropriate camera in the Multicam Viewer

 — Clicking on the appropriate camera number icon in the Filmstrip Viewer

 — Pressing the number key of the camera on the keyboard

The Viewer will then go into Single Clip mode, showing the camera you selected. To return to the Multi 
Viewer, click on the circled X close icon, or simply press the Escape key.

534The Cut Page | Chapter 28 Fast Editing in the Cut Page



The clip will automatically set an In point at your current timeline position, with a default duration of 
five seconds. You can then manually set the Out point of the clip wherever you want.

The Multicam Viewer selection

Make the Source Overwrite Edit
Once your clip’s edit points are chosen, click on the Source Overwrite button and your selected 
camera clip will be perfectly positioned in sync on your timeline. The playhead will then automatically 
advance to the clip’s Out point, the Multi Viewer will return, and so be instantly ready for the next edit.

Selected Camera 2 and Playhead In point on the Timeline, ready for Source Overwrite edit.
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The completed Source Overwrite edit showing Camera 2 
edited in, and the Timeline ready for the next edit

TIP: Because the actual media in the Sync Bin determines the overall limit of the clips, and 
not the Timeline, it is possible to scroll past the end of the Timeline to make an edit. When 
you are past the end of the Timeline, the playhead now represents the Out point instead, 
which allows the clip to backfill itself to fit the exact duration required to fill in the Timeline.

Resync Misaligned Synced Clips
While editing with synced Multicam clips, if your shot accidentally goes out of sync with the timeline, 
it will be indicated by a warning icon in the lower left of the clip. You can easily bring this clip back into 
sync again with the timeline by clicking on the Edit Actions icon, and selecting Resync Clip from the 
contextual menu.

If a clip accidentally 
slips sync in Multicam 
footage, a red sync 
warning indicator will 
now appear in the 
lower left of the clip.
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Audio Transcription and Text  
Based Editing (Studio Version Only)
The most critical metadata about any clip is knowing what people have said in it. A full transcription 
of a shot is useful in narrative film letting you find specific clips based on the dialog in the script, 
but a transcript is especially important in unscripted documentary and news production, both to 
understand what pieces of the story you actually captured and for a variety of organizational, creative, 
and legal requirements. 

Until recently, transcribing audio was a labor-intensive process, requiring a human being to listen to 
a clip in real time and then type out what was being said in a log sheet. With recent advances in the 
DaVinci Resolve Neural Engine, your computer can now perform the tedious work of transcribing 
each clip for you automatically, and most importantly, accurately. In addition, having text transcripts 
attached to the clips in your project gives you powerful new text-based editing tools to select, search, 
and insert clips into your timeline.

Transcribe Audio
The Transcribe Audio feature is accessed via the Media Pool in the Media, Cut, Edit, and Fairlight pages 
and is a fully automated process.

The Transcribe  
Audio icon in the 
Media and Edit pages

To automatically transcribe the audio of a clip:

1 Select a clip or clips with audio to transcribe in the Media Pool.

2 Right-click on any of the selected clips and select Audio Transcription > Transcribe from the 
contextual menu. Or click on the Transcribe Audio icon in the Media Pool toolbar.

The Transcribing 
Audio Window

At this point the Transcribing Audio window will appear, showing you how many clips are left to 
analyze, the speed at which the analysis is taking place vs. real time, and approximately how much 
longer the analysis of the selected clips will take. There is a button to cancel this operation at any time.
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The speech balloon 
icon showing that 
a clip has been 
transcribed 

Any clip that has a transcription attached to it will have a small speech balloon icon appear in the 
lower left of its thumbnail in the Media Pool.

To remove a transcription from a clip:

1 Select a clip you want to delete the transcription from in the Media Pool.

2 Right-click on the selected clips and select Audio Transcription > Clear Transcription from the 
contextual menu.

Audio Transcription of Timelines
Audio Transcription works not just with clips but for timelines as well and in the same way as 
described above. There are several practical uses for a text transcription of a timeline for legal and 
organizational requirements. However, if you’re intending to make subtitles or captions for the 
Timeline, there is a dedicated tool specifically for that purpose. For more information on the Create 
Subtitles from Audio feature, see Chapter 52, “Subtitles and Closed Captioning.”

The Transcription Window

The Transcription Window 
showing multiple clips 
with the Search pane open. 
The searched for text is 
highlighted in yellow. 

The In and Out range of the 
clip is highlighted in teal, 
and the current playhead 
position in the Viewer is 
indicated by a red triangle.
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The Transcription Window is where the text is displayed, along with its options and editing tools. 
For ease of use, the Transcription Window is freely movable around the GUI, even to another monitor.

To access the Transcription Window:

 — Right-click on a clip or clips that have been transcribed, and select Transcribe Audio from the 
contextual menu. Or click on the Transcribe Audio icon in the Media Pool toolbar.

The Transcription Window is comprised of the following sections and tools:

Export: Clicking this icon will launch a file browser, where you can save 
a .txt file of the transcription results for use in other programs.

Search: Clicking this icon will expose a Search and Replace dialog, letting you 
find specific words or phrases across all the selected clips in the Clips panel. 
Found words will be highlighted in yellow.

Options Menu: Reveals the Transcription Window options.  
Currently the only option is Remove Silent Portions.

Clips: This panel shows all the selected clips that you’ve chosen to see the transcription for. 
Clicking on a thumbnail loads that clip’s transcription into the Transcript window. 

The selected clip is outlined in orange. If you only selected one clip, this panel does not appear.

Transcript: Displays the transcription text. You can also use this box to select the playhead 
position and set in and out points of a clip, as described in the Text Based Editing section below.

Text View Controls: Allows you to control the font size and the high contrast settings 
of the text in the Transcript window.
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Create Subclip: Creates a new subclip of the shot based on the In and Out 
points set by the highlight in the Transcript window.

Marker: Places a marker at the word location that is highlighted in red, or if an 
In/Out range is highlighted, it will place a duration marker for the range instead.

Stop: Stops playback of the clip in the Viewer.

Play: Plays the clip forward in realtime in the Viewer.

Play in to Out: Plays forward only between the set In and Out range.

Insert: Performs an Insert edit of the selected range into the Timeline.

Append: Performs an Append edit of the selected range to the 
end of the Timeline.

Editing Text in the Transcription Window
Not everything transcribed in the audio of a clip is useful or wanted in the final transcription. Crew 
chatter, flubbed lines, and long silences can all be edited out, as well as mistakes fixed in the Audio 
Transcription process itself. 

Selecting Text
In order to edit text, you first need to select it in the Transcription Window. There are a few ways of 
doing so, depending on how much text you wish to select.

To select a specific word in the transcription:

 — Double-click on the word to select it and highlight it in teal.

To select a range of text in the transcription:

 — Click and drag over the text you want to edit to select it and highlight it in teal.

To select an entire paragraph in the transcription:

 — Triple-click on any word in the paragraph to select the whole paragraph and highlight it in teal.

To select all the text in the transcription:

 — Press Command-A to select all of the text and highlight it in teal.
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Editing Text
Once any text is selected (highlighted in teal), you can right-click on it to bring up the editing options. 
Clicking on any of the editing tools executes the action.

The Transcription Window Editing tools (l-r): Edit, Delete, Undelete, 
and Copy, accessed by right-clicking on any selected text.

 — Edit: Clicking on this tool brings up a text field, where you can perform simple edits on the 
selected text. You can use this to correct the transcription in terms of incorrect words, spelling 
mistakes, and adjusting proper names. Radically altering the text, such as replacing an entire 
paragraph with a two or three word summary, will have unpredictable effects if used for editing. 
This action is undoable.

 — Delete: Clicking this tool does not delete the selected text from the Transcription window as in a 
word processor, instead it will mark the text in orange with a strike-through. Any text thus marked 
will not appear in the exported transcript, nor will its range be inserted into the Timeline with any 
edit operation. This means a cut will appear in the Timeline where the deleted text range is in the 
transcript. Since the “deleted” words are all still there in the audio clip as they were recorded, it 
may be easier to think of this as an “exclude” operation rather than a deletion.

 — Undelete: Clicking on this tool reverses any previous deletion. It changes the orange strike-
through text back into normal text, allows it back into the exported transcription, and re-includes 
its range for editing purposes. 

 — Copy: Copies the selected range for use in other applications. There is no Paste command for the 
Transcription Window.

Understanding Silence (…) in the Transcription Window
In most shots, a significant portion of the audio clip will have no dialog at all. These silences are 
marked in the Transcription window as ellipses (…). As important as knowing where the dialog is, it’s 
also useful to know where it isn’t. These silences (…) can be treated just like words in the Transcription 
Window, meaning they can be deleted, and thus excluded from any editing operation. 

For example, say you have a long interview with frequent pauses between questions. You could 
cut this long clip up manually by setting In and Out points and picking out the individual questions 
and answers. But, by using Audio Transcription and deleting all the silences (…) in the Transcription 
Window and then editing that range into the Timeline, you would instantly have a series of individual 
clips laid down comprised of only the questions and the answers. This lets you automatically insert 
all of the relevant clips at once, without all the tedious scrubbing and setting of edit points for every 
single section of the clip in the Viewer.
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The original Interview clip (Tracks V1, A1 violet) and the same media with all 
silences removed using the transcription window (tracks V2, A2). Note how it 
is automatically broken into individual question and answer clips.

Removing silences in the Transcript Window has many useful applications for both exporting a 
transcript and in text based editing, and so has a dedicated tool for deleting them all.

To delete all the silences (…) in the Transcription Window:

 — Click on the Option menu in the upper right of the Transcription Window, and select Remove Silent 
Portions from the contextual menu.

Audio Transcription Supported Languages
You can choose which language is used to generate the transcription in the Project Settings > Subtitle 
and Transcription> Transcription Setup section. You can select any of the supported language models, 
or keep it on Auto for DaVinci Resolve to figure out who is speaking what.

As of this writing Audio Transcription and Text-Based Editing support the following languages:

 — Danish, Dutch, English, French, German, Italian, Japanese, Korean, Mandarin (Simplified, 
Traditional), Norwegian, Portuguese, Russian, Spanish, and Swedish.

Text-Based Video Editing
After a Transcribe command has been applied, DaVinci Resolve now knows the exact timecode position 
of each word in the clip, and that information opens up several useful text-based editing tools using 
the Transcription Window. Text-based video editing is available in the both the Cut and Edit pages.

The cursor in the Transcription Window and the playhead in the Viewer are linked. As you move the 
cursor in the text, the playhead updates to that respective position in the clip in the Viewer. This allows 
you to precisely place the playhead exactly where you want it based on the text word, rather than 
having to scrub back and forth through the audio track. 

To move the playhead to a specific word in the clip:

 — Click on a word in the Transcript Window, and it will highlight with a red arrow. The viewer 
playhead will then jump directly to the end of that word in the clip in the Viewer.

In addition to the cursor and playhead being linked, the In and Out points of a clip are also linked to 
the selected range of the text in the Transcription Window.
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To select an In and Out range in the clip:

 — Click and drag over the text in the Transcription Window to highlight it in teal. The In point of 
the clip is set just before the first word, and the Out point is set just after the last word in the 
highlighted text.

Selecting a text range in the Transcription Window (R), automatically sets 
In and Out points for that range on the clip in the Viewer (L).

With an In and Out range set, you can now use the editing tools in the Transcription Window to 
perform some common editing and media management functions.

The Create Subclip and Add Marker 
tools in the Transcription window

To create a new subclip from a selected range:

1 Select a range of text in the Transcription window by clicking and dragging to highlight the text in teal.

2 Press the Create Subclip icon in the lower left of the Transcription window.

3 In the Create Subclip window, enter a new name for the subclip and select the Create button.

To add a marker to a clip:

1 Either select a specific word in the Transcription window (red arrow) for a standard marker, or 
select a range of text by clicking and dragging to highlight the text in teal for a duration marker.

2 Click on the Marker icon in the lower left of the Transcription Window.

The Insert and Append edit icons 
in the Transcription window

To edit an In and Out range into the current timeline:

1 Select a range of text in the Transcription window by clicking and dragging to highlight the 
text in teal.

2 Click the Insert Edit icon in the lower right of the Transcription window to insert the selected range 
into the Timeline, or click on the Append icon to add the clip to the end of the Timeline.
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Chapter 29

Trimming in 
the Cut Page
Once you’ve assembled a sequence of clips together into 
a loosely edited timeline, the Cut page provides numerous 
methods for modifying them in the Timeline. 

These tools are intended to improve the pace of your program by fine-tuning the timing of each clip, 
as well as the edits that separate them them. The idea is to make these kinds of adjustments easy, so 
your program’s content is clear, and the timing of your program’s playback is satisfying. This process 
of making modifications to the edits in a timeline is referred to as “trimming.” 
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Tools That Help You Work 
in the Timeline
As you begin the process of trimming clips in the Timeline, a series of buttons at the top left of the 
Timeline help you to align clips and keep track of important frames while you work.

Ripple on Main Track Option to Disable Ripple Trims
When trimming on the main track (track 1) in the Cut page, you can disable the automatic rippling 
of the clips on that track. This lets you have the option to make simple trim adjustments without the 
other clips in the Timeline moving up and down the Timeline.

To Enable or Disable Rippling on a Cut Page Timeline:

 — Click on the Timeline Options icon and select Ripple On in the contextual menu, or click directly on 
the Ripple On icon to the left of the Timeline ruler. Click it again to toggle Rippling on or off.

 — Alternatively you can hold down the Option key while trimming with the mouse on the main track 
to temporarily disable rippling.

The Ripple On control 
toggles rippling on 
the main track.

Fixed or Free Playhead
You can choose whether to keep the default fixed playhead on the Cut timeline (video flows under the 
playhead), or have it move freely with the video instead (playhead flows over the video). To choose the 
mode, click on the Timeline Options icon, and check or uncheck Fixed Playhead,

 — When checked, the playhead is fixed in the center of the Timeline, and your edited clips scroll past 
it as you play (press the Spacebar), jog, or shuttle (use the JKL keys) in either direction. Locked 
mode works great when you use the DaVinci Resolve Editor Keyboard, because the Timeline flows 
past the playhead while you use the Jog/Shuttle/Scroll wheel. You can also scroll the Timeline 
using your pointer by dragging the Timeline Ruler at the top to the left or right, which also drags 
all of your clips to the left or right.

 — When unchecked, the playhead moves across the clips as you play (press the Spacebar), jog, or 
shuttle (use the JKL keys) in either direction; the clips stay still. This mode can be useful when 
you’re doing precision trimming in the Timeline using a pointing device, as the clips stay put while 
you drag parts of clips to make adjustments. Once the playhead gets to the right or left edge of 
the Timeline, the Timeline pages over to reveal the next part of your edit. You can also move the 
playhead by clicking in the Timeline Ruler to jump the playhead to that frame, or by positioning 
the pointer over the playhead’s top handle, or over the playhead itself, and dragging the playhead 
wherever you want it to go.
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Snapping
You can turn Snapping on or off by clicking the Timeline Options icon and checking or unchecking the 
magnet-shaped Snap icon, or press N to enable or disable snapping. 

When snapping is turned on, clip in and out points, markers, and the playhead all snap to line up with 
one another, making it easy edit clips together at their boundaries, or to line up clips with markers 
or the playhead as reference for key frames you want to cut to. When a clip’s boundary is snapping, a 
white line shows you the edges that are being aligned with one another.

NOTE: When the 
playhead is locked, clips 
don’t snap to it.

The indicator that appears 
when clip boundaries are 
snapping to another edge

However, it’s also important to be able to turn snapping off when this behavior impedes your ability to 
make small adjustments to clips in the Timeline. You can press N to temporarily turn snapping on or 
off while you’re in the middle of dragging a clip in the Timeline, or while scrubbing the playhead using 
the pointer. 

 — When you change snapping while dragging a clip, an edge, or the Timeline, it’s considered to 
be a temporary operation, and snapping reverts to its previous state when you release the 
mouse button.

 — When you change snapping in between dragging operations, the snapping state remains set until 
the next time you change it.

Locking, Muting and Disabling Tracks
As you work in the Timeline, you may find it useful to lock tracks with clips you don’t want to 
accidentally change as you work. For example, you might lock an audio track that has an edited piece 
of music you’re now cutting other video and audio clips to, so you don’t accidentally alter or trim the 
music that serves as the base of your program. Clips on locked tracks appear stippled to let you know 
they can’t be altered.

A locked audio track, the Lock icon is closed and clips on that track are stippled

You may also find it useful to mute the audio or disable the video of tracks you don’t want to see while 
playing the Timeline. For example, you might want to disable a track filled with title graphics if you 
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want to get a closer look at the underlying video in the background. Each track has Mute and Enable 
controls, while audio-only tracks only have Mute controls. White controls are enabled, while gray 
controls are disabled.

Track 1 is disabled; the Enable button is orange and clips on the track are dimmed

Audio Trim View
When performing a trim operation in the Cut page, you can set the option to expand the audio 
waveform of a Timeline clip while trimming. This mode gives a much more accurate view of the audio, 
making it easier to pick a specific edit point between words, beats, etc.

To toggle Audio Trim view: 

 — Click the Timeline Options icon, and check Trim to Audio.

With this option enabled, you’ll see an expanded waveform for audio/video clips that are 
being trimmed in the Timeline, while you’re trimming. This shrinks back down after you finish 
the trim operation.

The Audio Trim view showing an expanded audio 
waveform while trimming in the Timeline

Timeline Markers
You can place markers in the Timeline Ruler (of both the Upper Timeline and the Timeline Editor) to 
keep track of important frames of clips you want to remember, alternate edit points you’re thinking of, 
key moments in the edit, or to make notes of things you need to do. You can edit marker text, which 
appears as an overlay in the Viewer, and you can change the color of markers to distinguish them from 
one another.

The Marker button in the 
Timeline track header
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Methods of working with markers:

 — To add a marker: Move the playhead to a frame you want to mark, then click the Marker button in 
the Timeline header, or press the M key. You can also add a marker from the Timeline Actions icon.

 — To add a marker with a specific color: Move the playhead to a frame you want to mark, then 
click the Timeline Actions icon, and select Set Color and Add Marker. This will both add a marker 
and open the Markers Edit window, letting you pick a specific color and add a comment. 

 — To jump the playhead among markers: Hold the shift key and press the Up or Down Arrow keys 
to jump the playhead from marker to marker.

 — To edit a marker’s name, text, color, or keywords: Double-click a marker, or jump the playhead 
to a marker and press M again. When the marker dialog opens, edit the Name, Notes field, 
Keyword field, or color of the marker, then press Return or click Done to close the dialog. Markers 
with custom notes appear with a dot.

 — To move a marker: Drag a marker to another frame in the Timeline Ruler.

 — To delete a marker: Select a marker, and press Delete. Or, align the playhead with a marker, and 
press Option-M. Or, jump the playhead to a marker, press M to open the marker dialog, and then 
click Remove Marker.

Blue, red, and orange markers in the Timeline; the red marker contains text, the others do not

Making Selections
As you continue to work in the Cut page, it becomes increasingly helpful to know how to make 
different kinds of selections, both in the Media Pool and in the Timeline. Most of these methods 
of selection should be familiar to you if you have experience with other media applications or 
file managers.

Methods of selecting clips in the Media Pool:

 — To select a single clip: Click a clip in the Media Pool. Once you’ve selected a clip, you can use the 
Up and Down arrow keys to move the selection to other clips.

 — To select a contiguous range of clips: Drag a selection box over all the clips you want to select, 
or click to select the first clip in a series, then Shift-click the last clip to select those clips and 
everything in between.

 — To select a noncontiguous range of clips: Command-click each clip you want to include in 
the selection. Or, you can hold the Command key down while you drag bounding boxes over 
unselected clips to add them to the current selection, or over selected clips to remove them from 
the selection.

 — To select all clips: Select one clip, then choose Edit > Select All (Command-A).
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Methods of selecting clips in the Timeline:

 — To select one clip: Click a clip with the mouse. Command-clicking that clip de-selects it.

 — To de-select all clips in the Timeline: Click in any empty area of the Timeline to de-select 
everything, or press Command-Shift-A.

 — To select a continuous range of clips by dragging: Drag a bounding box from an empty area of 
the Timeline to surround a group of clips.

 — To select a continuous range of clips by Shift-clicking: Click the first clip you want to select, 
and then Shift-click the last clip you want to select, and all clips in-between will automatically be 
selected as well.

 — To select a discontinuous range of clips: Command-click any clips to select them no matter 
where they appear on the Timeline. Command-clicking a selected clip deselects it.

 — To select all clips under the playhead: You can select all the clips under the playhead at once, 
regardless of how many tracks they are spread across by selecting Trim > Select All Clips Under 
Playhead (Option-Shift-V).

 — To select all clips in the Timeline from the playhead forward: Right-click the top handle of the 
playhead, and click the right button on the radial menu that appears.

 — To select all clips in the Timeline from the playhead backward: Right-click the top handle of 
the playhead, and click the left button on the radial menu that appears.

The radial menu that appears 
when you right-click the 
top handle of the playhead

Methods of selecting edits in the Timeline using the pointer:

 — To select an edit to roll: Move the mouse to the center of an edit point, and when the ripple 
cursor appears, click to select the edit.

 — To select just the incoming or outgoing half of an edit point to resize: Move the mouse to the 
left or right of the center of an edit, and when the resize/ripple cursor appears, click to select that 
portion of the edit.

 — To select multiple roll points: Command-click the center of multiple edit points. Command-click 
a selected edit point to deselect it.

 — To select multiple resize points: Command-click the left or right sides of multiple edit points.

 — To de-select all clips in the Timeline: Click in any empty area of the timeline to 
de-select everything.

Keyboard shortcuts for selecting edits in the Timeline:

 — To select an edit point from the keyboard: Press V to select the nearest edit 
point to the playhead.

 — To change an edit selection from the keyboard: Once you’ve selected an edit point, 
press U to toggle among selecting the outgoing half, incoming half, or the entire edit.

 — To de-select all edits in the timeline: Press Command-Shift-A.
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Moving Clips in the Timeline
Once you’ve edited some clips into the Timeline, you’ll probably want to start fine-tuning the edit by 
moving clips around. Different operations can be performed depending on how you move these clips. 
All of these techniques work in both the Upper Timeline and the Timeline Editor.

Ripple Overwriting An Entire Clip in Track 1
Drag a clip in the Timeline or Upper Timeline over another clip in the Timeline so that the pointer 
overlaps that clip, and quickly drop it onto another clip in Track 1. The clip you dragged replaces the 
clip you dropped it onto, and all clips to the right are moved to either make room (if the dragged clip is 
longer) or to close the gap (if the dragged clip is shorter).

Clicking clip BB to begin dragging it

Dragging clip BB onto clip DD to ripple overwrite it

Clip BB is moved and takes the place of clip DD, while the rest of 
the Timeline moves left to close the gaps in Track 1

NOTE: If you wait too long, this Ripple Overwrite operation will turn into an overwrite 
operation. If you drag a clip in Track 1 onto a clip in any other track, you can only do an 
overwrite, not a ripple overwrite.
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Overwriting the Middle of Other Clips
Drag a clip in the Timeline or Upper Timeline over another clip in the Timeline so that the pointer overlaps 
that clip, and pause until the clip you’ve selected is overlaid on top of the second clip, and release the 
mouse button. The target clip is overwritten by the duration of the clip you dragged and split in two.

(Top) Dragging clip BB 
and pausing to overwrite 
part of clip DD 

(Bottom) Clip BB is moved, 
overwriting the middle 
of clip DD which is now 
in two pieces; the rest 
of the Timeline moves 
left to fill the gap left by 
moving clip BB in Track 1

Overwriting The Edges of Other Clips
Drag a clip in the Timeline or Upper Timeline over the edge of a neighboring clip without letting your 
pointer overlap it, then drop the clip. The overlapping part of the neighboring clip will be overwritten.

(Top) Dragging clip CC to 
partially overlap clip DD 
in order to overwrite it 

(Bottom) After dropping 
clip CC to partially 
overwrite the beginning 
of clip DD, clip DD is 
shortened and the 
other clips in the 
Timeline move left to 
fill the gap in Track 1

Swapping Clips
Drag one or more clips from one part of the Timeline or Upper Timeline to another so that the pointer 
overlaps an edit between two clips (the edit point turns purple), and drop the clip. The clip(s) you 
dragged are now moved so that they’re inserted at the edit point you targeted.

Dragging clip CC to swap it between clip II and JJ
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Dropping clip CC rearranges the Timeline, which automatically closes all gaps and move clips to the 
right where necessary; superimposed clips are kept in sync with clips in Track 1 that have moved

Copy, Cut, and Paste
Clips can be cut, copied, and pasted in the timeline or Upper Timeline to duplicate them or move them 
around, just like words in a word processor. 

To cut/copy and paste in the Timeline:

1 Select one or more clips in the Timeline.

2 Do one of the following:

a) Press Command-C to copy them (the selected clips remain where they are).

b) Press Command-X to cut them (the selected clips are removed and the Timeline 
automatically ripples itself to close the gap).

c) Move to another part of the Timeline, then press Command-V to paste the clips. The clips are 
pasted to the frame at the playhead, to the same track they were copied from, and overwrite 
whatever other clips are at that part of the Timeline.

Splitting Clips
You can split any clip into two pieces, effectively adding an edit point in the middle, in preparation 
for moving part of a clip, deleting part of a clip, inserting another clip at that edit point, or adding an 
effect of some kind to one part of a clip but not another.

To split a clip:

1 Move the playhead to the frame of a clip where you want to split it. 

2 Do one of the following:

 — Click on the Edit Actions icon, and select split from the drop-down menu.

 — Right-click the top handle of the playhead and click the Split button that appears on 
the radial menu.

 — Press Command-Backslash.

 — Press the Split Clips (scissor) icon on the far left of the Cut page Edit commands.

(Left) Before 
splitting a clip, 
(Right) After, a 
new edit point 
bisects the clip 
into two pieces

552The Cut Page | Chapter 29 Trimming in the Cut Page



Disabling and Deleting Clips
Clips that you no longer want can be disabled or deleted.

Disabling and Muting Clips
You can turn off the audio and/or video for a clip in the Timeline, without removing the clip itself. This 
is useful in instances where you want to use a clip’s audio or video selectively, or for instances where 
you want to disable the audio and video for a clip that you don’t want to use, without eliminating it 
completely from the Timeline in case you change your mind.

Disabling Clips
You can turn off a clip’s video while leaving it in the Timeline by selecting it and pressing D, or by right-
clicking it and deselecting Enable from the contextual menu. The clip turns dull to show it’s disabled. 
Audio will continue to play for that clip unless you mute it as well.

A disabled clip in the Timeline

Muting Clips
You can turn off a clip’s audio while leaving it in the Timeline by right-clicking it and choosing Mute 
from the contextual menu. A mute icon is superimposed over the beginning of the clip to show audio 
is disabled. Video will continue to play for that clip unless you disable it as well.

A muted clip in the Timeline
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Deleting Clips
If you want to completely eliminate one or more clips from the Timeline, select them and press the 
Delete key. The clip(s) will be removed. If you’ve deleted a clip on Track 1, the Timeline will ripple to 
close the gap automatically.

Selecting clip DD to delete it

Deleting clip DD results in clips EE through NN moving left to fill the gap in Track 1; 
superimposed clips move to keep in sync with the clips underneath them

Deleting Parts of Clips
If you want to delete only part one or more clips, set In and Out points around the section of the 
Timeline you want to delete, and press the Delete key. The section of the Timeline between the In and 
Out points will be removed. If you’ve deleted part of a clip on Track 1, the Timeline will ripple to close 
the gap automatically.

Marking In and Out points to delete that section of the Timeline

After deleting whatever’s between the In and Out points, all clips to the 
right of the marked section move left to close the gap in Track 1
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Trimming Clips
You can also quickly modify your edited timeline by resizing the In and Out points of any clip, moving 
the edit points between clips, and slipping the contents of a clip.

Resize Clips While Rippling the Timeline
If you move the pointer over the far left or right edge of a clip in the Timeline or Upper Timeline, it 
turns into a Resize icon to indicate that you can drag the In or Out point of that clip to make it shorter 
or longer, in the process rippling all clips to the right in the Timeline to accommodate the new length 
of the clip. While you drag, a tooltip shows you how many frames you’ve moved the clip and the clip’s 
new duration. As you do so, the audio will scrub along with the Resize cursor.

If you resize a clip in Track 1, the rest of the edited timeline automatically ripples to accommodate the 
changes you’ve made, with clips to the right of the changed area moving left to fill the gap of a deleted 
or shortened clips, or moving right to make room for an inserted or lengthened clip.

(Top) Clicking the Out 
point of clip DD in Track 1

(Bottom) Dragging to 
shorten clip DD ripples the 
Timeline; a tooltip appears 
to show you how many 
frames you’ve resized

Moving or resizing clips on Track 2 and above only moves or resizes that one clip; other 
clips in the Timeline are not rearranged and the Timeline is not rippled when you do this.

(Top) Clicking the out 
point of clip HH in Track 2

(Bottom) Dragging to 
lengthen the clip doesn’t 
ripple the Timeline
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TIP: When you resize the Out point of a clip on Track 1 that’s underneath a superimposed 
clip, and the superimposed clip has an In point that’s to the right of the In point of the clip 
you’re resizing, then dragging the Out point of the clip you’re trimming past the left of the 
In point of the superimposed clip will delete that superimposed clip from the Timeline.

Rolling an Edit
You can click and drag any edit point between two clips in the Timeline or Upper Timeline to 
“roll” it, basically resizing the Out point of the outgoing clip and the In point of the incoming clip 
simultaneously. This lets you move an edit point without changing the duration of the overall timeline. 
While you drag, a white overlay in the Timeline lets you see how much media you have available for 
rolling (depending on the available handles in the source media). As you do so, the audio will scrub 
along with the right clip’s In point.

(Top) Clicking an edit 
between clips CC and DD

(Bottom) Dragging to 
the right rolls it forward, 
simultaneously resizing 
clips CC and DD

Slipping Clip Content
For each clip in the Timeline, a Slip handle appears at the center of the clip. Dragging this handle lets 
you slip the contents of that clip to present a different range of media, without changing the position 
or duration of the clip, and without changing any other part of the Timeline.

You can even select multiple clips, such as two superimposed clips, or a number of clips in a row, and 
slip them all at the same time. While you drag, a white overlay in the Timeline lets you see how much 
media you have available for slipping (depending on the source clip’s duration).
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(Top) Clicking a clip’s slip handle, (Bottom) Dragging a clip’s slip 
handle to change the range of media within that clip

Roll and Trim Audio Edit Points to Add Split Edits
You can independently trim the audio channel of a video clip in the Cut page. This allows you to do a 
split edit (L-cut or J-cut), where the audio of one video clip is extended under the video of a different 
clip. This lets you manipulate the flow and rhythm of a scene in terms of reaction shots and more 
natural sounding dialogue. 

To Trim Audio Only and Perform a Split Edit on a Cut Page Timeline:

 — Expand the track on the Cut page by clicking on the Enlarge Track icon on the left side of the track 
header. This is not strictly necessary but makes it easier to find the correct trigger point for the 
tool and see the audio waveform as you’re trimming it.

 — Hover the pointer over the edit point in the lower audio portion of the track. When the trim icon 
shows a musical note to the right, you can then slide that edit point back and forth and only the 
audio portion of the clip will be expanded forwards or backwards.

 — The Trim View will also appear in the Viewer as you edit, along with expanded audio waveforms 
that are zoomed into the frame level for precision.

Placing the pointer in the audio part of the 
track triggers the trim indicator with the 
musical note icon. This allows you to drag 
just the audio edit point back and forth in 
the Timeline, leaving the video in place.
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Trim or Extend Clip to Playhead
You can easily trim or extend a clip to a specific length by positioning the playhead on the Timeline 
exactly where you want the video to start or end and then selecting the appropriate operation by 
clicking on the Edit Actions icon.

To Trim or Extend Clip to Playhead:

 — Place the playhead at the point that you wish to either extend the clip to, or cut the clip off at.

 — Click on the Edit Actions icon.

 — Select Trim Start to Playhead from the contextual menu to cut or extend the left side of the clip to 
the playhead position.

 — Select Trim End to Playhead from the contextual menu to cut or extend the right side of the clip to 
the playhead position.

(Top) The original Timeline with playhead intersecting between the second and 
third set of “BB’s,” (Middle) The resulting clip when Trim Start to Playhead is selected, 
(Bottom) The resulting clip when Trim End to Playhead is selected

Trimming Edits in the Viewer
You can double-click any edit point between two clips in the Timeline or Upper Timeline to open up 
the Trim Editor, which provides a detailed method of adjusting both halves of an edit point. A graphical 
A/B roll interface shows two filmstrips with the outgoing clip on top and the incoming clip on the 
bottom. These controls are draggable:

 — Drag the left side of the top filmstrip’s handle to trim the Out point of the outgoing clip

 — Drag the right side of the bottom filmstrip’s handle to trim the In point of the incoming clip

 — Drag the white handle between the top and bottom filmstrips to roll the edit point, simultaneously 
adjusting the outgoing and incoming edit points
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Numbers over each frame let you see exactly how many frames you’re trimming, while a pair of 
buttons to the left and right of the transport controls in the Viewer toolbar let you adjust the outgoing 
clip’s Out point and incoming clip’s In point in one frame increments.

The Viewer Trim Editor seen when you double-click an edit in the Timeline

Trimming Transitions in the Viewer
If you double-click a transition, that transition appears sandwiched between the outgoing and 
incoming clips, with handles you can use to trim the transition’s length, as well as the outgoing and 
incoming halves of the edit point to which the transition is applied.

The Viewer Trim Editor seen when you double-click a transition in the Timeline
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Chapter 30

Using the Inspector 
in the Cut Page
The Inspector holds all the controls to modify, resize, retime, and 
generally adjust anything related to a clip, transition, or effect on 
the Cut page Timeline.

Contents
Using the Inspector  561

Video  561

Audio  569

Effects  571

Transition  572

Image  573

File  574

560The Cut Page | Chapter 30 Using the Inspector in the Cut Page



Using the Inspector
The Inspector has been redesigned to make it easier to find specific controls and to adjust common 
settings for your clips. Instead of a long vertical list, different aspects of the Inspector have now been 
organized into panels, with each controlling specific grouped sets of parameters for your clip. 

The Inspector is activated by clicking on the Inspector Panel in the upper-right section of the User 
Interface toolbar. The Inspector is broken up into individual Video, Audio, Effects, Transition, Image, 
and File panels. Inspector panels that are not applicable to your clip or selection are grayed out.

The Inspector Panel icon in the upper right of the UI toolbar

The Inspector panels showing Video, Audio, and File parameters 
available for adjustment; others are grayed out.

Methods of using controls in the Inspector:

 — To activate or deactivate a control: Click the toggle to the left of the control’s name. 
The orange dot on the right means the control is activated. A gray dot on the left means the 
control is deactivated. 

 — To reveal a control’s parameters: Double-click the control’s name.

 — To reset controls to their defaults: Click the reset button to the right of the control’s name.

Video
The Video panel of the Inspector exposes a vast array of controls designed to manipulate the size, 
speed, and opacity of your clips. 

Transform
The Transform group includes the following parameters for resizing and repositioning your clips: 

The Transform section of the Video Inspector panel
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 — Zoom X and Y: Allows you to blow the image up or shrink it down. The X and Y parameters can 
be linked to lock the aspect ratio of the image, or released to stretch or squeeze the image in one 
direction only.

 — Position X and Y: Moves the image within the frame, allowing pan and scan adjustments to be 
made. X moves the image left or right, and Y moves the image up or down.

 — Rotation Angle: Rotates the image around the anchor point.

 — Anchor Point X and Y: Defines the coordinate on that clip about which all transforms are 
centered. 

 — Pitch: Rotates the image toward or away from the camera along an axis running through the 
center of the image, from left to right. Positive values push the top of the image away and bring 
the bottom of the image forward. Negative values bring the top of the image forward and push 
the bottom of the image away. Higher values stretch the image more extremely.

 — Yaw: Rotates the image toward or away from the camera along an axis running through the 
center of the image from top to bottom. Positive values bring the left of the image forward and 
push the right of the image away. Negative values push the left of the image away and push the 
right of the image forward. Higher values stretch the image more extremely.

 — Flip Image: Two buttons let you flip the image in different dimensions.

 — Flip Horizontal control: Reverses the image along the X-axis, left to right.

 — Flip Vertical control: Reverses the clip along the Y-axis, turning it upside down.

Smart Reframe (Studio Version Only)
The Smart Reframe feature makes it easier to quickly reframe material across extreme aspect ratio 
changes. It’s useful for situations where you’ve shot a 16:9 horizontal video and find yourself needing 
to create a vertically-oriented 9:16 version for mobile phones and social media deliverables, or 
using 4:3 archival footage in a 2.39:1 widescreen movie. Smart Reframe can be used manually, or 
automatically executed using the DaVinci Resolve Neural Engine.

The Smart Reframe section of 
the Video Inspector panel

 — Object of Interest: Tools for selecting the subject that the resize will frame around.

 — Auto: DaVinci Resolve’s Neural Engine will analyze the clip and choose its most representative 
object. This will be the only option if more than one clip is selected for Smart Reframing.

 — Reference Point: Allows you to manually adjust a bounding box around the 
subject to reframe around.

 — Reframe: This button executes the Smart Reframe command. This can take some time depending 
on the length and number of clips.
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Cropping
The Video Inspector controls the image’s cropping parameters. 

The Cropping section of the Video Inspector panel

 — Crop Left, Right, Top, and Bottom: Lets you cut off, in pixels, the four sides of the image. 
Cropping a clip creates transparency so that whatever is underneath shows through.

 — Softness: Lets you blur the edges of a crop. Setting this to a negative value softens the 
edges inside of the crop box, while setting this to a positive value softens the edges 
outside of the crop box.

 — Retain Image Position: Clicking this checkbox will lock the crop parameters in place when you 
resize the image using the Transform tool above. Unchecking this box will scale and position the 
crop as well as the image.

Dynamic Zoom
The Dynamic Zoom controls, which are off by default, make it fast and easy to do pan and scan 
effects to zoom into or out of a clip. Turning the Dynamic Zoom group on activates two controls in 
the Inspector that work hand-in-hand with the Dynamic Zoom onscreen adjustment controls. 
For more information on using the Dynamic Zoom controls, see Chapter 50, “Compositing and 
Transforms in the Timeline.” 

The Dynamic Zoom section of the Video Inspector panel

 — Dynamic Zoom Ease: Lets you choose how the motion created by these controls accelerates. 
You can choose from Linear, Ease In, Ease Out, and Ease In and Out.

 — Swap: This button reverses the start and end transforms that create the dynamic zoom effect.
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Composite
Composite modes can be used to combine clips that are superimposed over other clips in 
the Timeline. 

The Composite section of the Video Inspector panel

 — Composite Mode: This selects the type of composite mode to combine the superimposed clips. 
The default “Normal” means no compositing mode is applied. For more information on Composite 
Modes, see Chapter 50, “Compositing and Transforms in the Timeline.”

 — Opacity: This slider makes a clip more or less transparent in addition to compositing 
already being done.

Speed Change
You can change the speed of your clip directly in the Video Inspector’s Speed Change controls. 
This method has the benefit of being available in both Cut and Edit pages. 

The Speed Change controls in the Video Inspector

 — Direction: Selects the desired motion of the clip, forward, backward, or freeze frame.

 — Speed %: Adjusting this slider changes the clips motion on a percentage basis. 
This value can be keyframed.

 — Frames Per Second: Adjusting this slider changes the clips motion by increasing or decreasing 
the number of frames per second to play the clip back at. This value can be keyframed.

 — Duration: You can directly select how long you want the clip to be by setting a specific duration 
here in HH:MM:SS:FF format. This will then automatically adjust the speed of the clip to playback all 
frames in that exact amount of time.

 — Ripple Sequence checkbox: If you want the speed change you’re about to make to ripple the 
Timeline, pushing or pulling all clips following the current one to accommodate the clip’s new size, 
then turn on this checkbox.

 — Pitch Correction checkbox: Checking this box will perform pitch correction on the audio 
attached to the clip so that while the audio duration is changed to match the picture speed, it will 
still sound natural. Be aware that pitch correction on large speed adjustments may not sound as 
good as pitch corrections made to small speed adjustments.
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Stabilization
These controls let you smooth out or even steady unwanted camera motion within a clip. 

The Stabilization section of the Video Inspector panel

The analysis is performed in such a way as to preserve the motion of individual subjects within the 
frame, as well as the overall direction of desirable camera motion, while correcting for unsteadiness.

These are the same stabilizer controls found in the Color page’s Tracker palette (minus the tracker 
graph), and the resulting stabilization analysis is mirrored on the Color page, where you can see the 
data visualized on the graph, if necessary.

A pop-up menu provides three different options that determine how the selected clip is analyzed and 
transformed during stabilization. You must choose an option first, before clicking the Stabilize button 
above, because the option you choose changes how the image analysis is performed. If you choose 
another option, you must click the Stabilize button again to reanalyze the clip.

 — Perspective: Enables perspective, pan, tilt, zoom, and rotation analysis and stabilization.

 — Similarity: Enables pan, tilt, zoom, and rotation analysis and stabilization, for instances where 
perspective analysis results in unwanted motion artifacts.

 — Translation: Enables pan and tilt analysis and stabilization only, for instances where only X and Y 
stabilization gives you acceptable results.

The other controls let you customize how aggressively the selected clip is stabilized.

 — Stabilization Toggle: The toggle control for the Stabilization controls lets you turn stabilization 
off and on to be able to compare the stabilized and unstabilized image.

 — Camera Lock: Turning on this checkbox disables Cropping Ratio and Smooth, and enables 
the stabilizer to focus on eliminating all camera motion from the shot in an effort to create a 
locked shot.

 — Zoom: When this checkbox is turned on, the image is resized by a large enough percentage to 
eliminate the blanking (black edges) that is the result of warping and transforming the image 
to eliminate unwanted camera motion. The lower a value Cropping Ratio is set to, the more 
DaVinci Resolve will need to zoom into an image to eliminate these blanked edges. If you turn 
this off, the image is not zoomed at all, and whatever blanking intrudes into the image is output 
along with the image, on the assumption that you’ll have dedicated compositing artists deal with 
eliminating this blanking by filling in the missing image data in a more sophisticated manner. You 
may also leave this checkbox turned off if you’re planning on animating the Input Sizing Zoom 
parameter to dynamically zoom into and out of a shot being stabilized to eliminate blanking only 
where it occurs, using only as much zooming as is necessary for each region of the shot.
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 — Cropping Ratio: This value limits how hard the stabilizer tries to stabilize, by dictating how much 
blanking or zooming you’re willing to accept in exchange for eliminating unwanted motion. 
A value of 1.0 results in no stabilization being applied. Progressively lower values enable more 
aggressive stabilization. Changing this value requires you to click the Stabilize button again to 
reanalyze the clip.

 — Smooth: Lets you apply mathematical smoothing to the analyzed data used to stabilize the clip, 
allowing camera motion in the shot while eliminating unwanted jittering. Lower values perform 
less smoothing, allowing more of the character of the original camera motion to show through, 
while higher values smooth the shot more aggressively. Changing this value requires you to click 
the Stabilize button again to reanalyze the clip.

 — Strength: This value is a multiplier that lets you choose how tightly you want to use the 
stabilization track to eliminate motion from a shot using the current analysis. With a value of 1, 
stabilization is maximized. Since some clips might look more natural with looser stabilization, 
choosing a number lower than 1 lets a percentage of the original camera motion show through. 
Zero (0) disables stabilization altogether. As an additional tip, you can invert the stabilization 
by choosing –1 when pasting a stabilization analysis from another clip to perform a match move 
based on the overall motion of the scene, and you can use a negative value either lower than 0 or 
higher than –1 to under or overcompensate when inverting the stabilization, simulating the effects 
of parallax where foreground and background planes move together but at different speeds.

Lens Correction
The Lens Correction group (only available in Resolve Studio) has two controls that let you correct for 
lens distortion in the image, or add lens distortion of your own.

The Lens Correction section of 
the Video Inspector panel

 — Analyze: Automatically analyzes the frame in the Timeline at the position of the playhead 
for edges that are being distorted by wide angle lens. Clicking the Analyze button moves the 
Distortion slider to provide an automatic correction. If you’re analyzing a particularly challenging 
clip, a progress bar will appear to let you know how long this will take.

 — Distortion: Dragging this slider to the right lets you manually apply a warp to the image that lets 
you straighten the bent areas of the picture that can be caused by wide angle lenses. If you clicked 
the Analyze button and the result was an overcorrection, then dragging this slider to the left lets 
you back off of the automatic adjustment until the image looks correct.
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Retime and Scaling
The Retime and Scaling group has four parameters that affect retiming quality and clip scale: 

The Retime and Scaling section of the Video Inspector panel

 — Retime Process: Lets you choose a default method of processing clips in mixed frame rate 
timelines and those with speed effects (fast forward or slow motion) applied to them, on a clip-by-
clip basis. The default setting is “Project Settings,” so all speed-effected clips are treated the same 
way. There are three options: Nearest, Frame Blend, and Optical Flow, which are explained in more 
detail in the Speed Effect Processing section of Chapter 51, “Speed Effects.”

 — Motion estimation mode: When using Optical Flow to process speed change effects or clips with 
a different frame rate than that of the Timeline, the Motion Estimation pop-up lets you choose 
the best-looking rendering option for a particular clip. Each method has different artifacts, and 
the highest quality option isn’t always the best choice for a particular clip. The default setting is 
“Project Settings,” so all speed-effected clips are treated the same way. There are several options. 
The “Standard Faster” and “Standard Better” settings are the same options that have been 
available in previous versions of DaVinci Resolve. They’re more processor efficient and yield good 
quality that are suitable for most situations. However, “Enhanced Faster” and “Enhanced Better” 
should yield superior results in nearly every case where the standard options exhibit artifacts, at 
the expense of being more computationally intensive, and thus slower on most systems. 

The Speed Warp setting is available for even higher-quality slow motion effects using the 
DaVinci Neural Engine. Your results with this setting will vary according to the content of the clip, 
but in ideal circumstances this will yield higher visual quality with fewer artifacts than even the 
Enhanced Better setting. 

 — Scaling: Lets you choose how clips that don’t match the current project resolution are handled on 
a clip-by-clip basis. The default setting is “Project Settings,” so that all mismatched clips use the 
same method of being automatically resized. However, you can also choose an individual method 
of automatic scaling for any clip. The options are Crop, Fit, Fill, and Stretch; for more information 
see the 2D Transforms section of Chapter 149, “Sizing and Image Stabilization.”

 — Resize Filter: For clips that are being resized in any way, this setting lets you choose the filter 
method used to interpolate image pixels when resizing clips. Different settings work better for 
different kinds of resizing. There are four options:

 — Sharper: Usually provides the best quality in projects using clips that must be scaled up to fill 
a larger frame size, or scaled down to HD resolutions.

 — Smoother: May provide higher quality for projects using clips that must be scaled down to fit 
an SD resolution frame size.

 — Bicubic: While the Sharper and Smoother options are slightly higher quality, Bicubic is still an 
exceptionally good resizing filter and is less processor intensive than either of those options.

 — Bilinear: A lower quality setting that is less processor intensive. Useful for previewing your 
work on a low-performance computer before rendering, when you can switch to one of the 
higher quality options.
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 — Other Resize Methods: A selection of specific resize algorithms is available if you need to 
match them to other VFX workflows.

 — Deinterlace Quality (Interlaced Clips Only): Allows per clip deinterlace quality 
adjustments regarding how DaVinci Resolve combines the two fields of interlaced media into 
progressive frames.

 — Normal: A high-quality deinterlacing method that is suitable for most clips. For many clips, 
Normal is indistinguishable from High. Normal is always used automatically during playback in 
DaVinci Resolve.

 — High: A more processor-intensive method that can sometimes yield better results, depending 
on the footage, at the expense of slower rendering times.

 — DaVinci Neural Engine: This option uses the advanced machine learning algorithms of 
the DaVinci Neural Engine to analyze motion between the fields of interlaced material and 
reconstructs them into a single frame. This option is very computationally intensive but, 
ideally, will deliver an even more aesthetically pleasing result than the “high” setting.

Super Scale
For instances when you need higher-quality upscaling than the standard Resize Filters allow, you 
can now enable one of the “Super Scale” options in the Inspector. Unlike using one of the numerous 
scaling options in the Edit, Fusion, or Color pages, Super Scale actually increases the source resolution 
of the clip being processed, which means that clip will have more pixels than it did before and will 
be more processor-intensive to work with than before, unless you optimize the clip (which bakes in 
the Super Scale effect into the optimized media) or cache the clip in some way. For more detailed 
information on Super Scale, see Chapter 11, “Image Sizing and Resolution Independence.”

Using Super Scale in the Inspector is functionally equivalent to setting the same controls for the media 
clip in the Clip Attributes. This means that changing this setting affects all of the additional edits 
referencing the selected media as well.

The Super Scale parameters

The Super Scale group has the following parameters that affect the quality and clip scale:

 — Super Scale: Lets you choose the amount of scaling required. The options are: 2x, 2x Enhanced, 
3x, or 4x. 

 — Sharpness: Lets you choose the amount of detail in the scaling. This is limited to Low, Medium, 
or High, unless the Super Scale Mode is set to 2x Enhanced, which allows you to apply variable 
sharpness. You will want to balance this setting against Noise Reduction.

 — Noise Reduction: Lets you choose the amount of noise reduction in the scaling. This is limited 
to Low, Medium, or High, unless the Super Scale Mode is set to 2x Enhanced, which allows you to 
apply variable noise reduction. You will want to balance this setting against Sharpness.
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Audio
The Audio tab contains four commonly used audio controls for video editing purposes, including Clip 
Volume, Clip Pan, Clip Pitch, and Clip Equalizer.

The Audio Inspector parameters

 — Clip Volume: Each clip has a single volume control that corresponds to the volume overlay over 
each audio clip.

 — Clip Pan: (Only exposed for clips) A simple Pan slider that controls stereo panning.

 — Voice Isolation (Studio Version Only): Voice Isolation is a plugin that can remove loud, 
undesirable sounds from existing voice recordings. This effect utilizes AI to provide models that 
let you completely remove undesired sounds. The AI model is trained for any type of human 
voice, male or female, young or old, so you can get incredible results that isolate dialog from 
background sounds in a recording, including everything from air conditioning or fans to extremely 
loud sounds like a jackhammer, restaurant background noise, or music playing at the same time 
that the subject is speaking, and so on.

 — Amount: Lets you adjust the amount of voice isolation processing.

569The Cut Page | Chapter 30 Using the Inspector in the Cut Page



 — Dialogue Leveler: The Dialogue Leveler analyzes source material to detect dialog, and then “ride 
down” louder areas, “lift up” softer areas, and lower background sounds that are not dialog. It 
works without typical dynamics processor “pumping” (compression/limiting) or other obvious 
side effects and produces results similar to detailed manual clip gain adjustments or by carefully 
“riding” the track with fader automation.

 — Preset Menu: The preset menu provides the following options:

 — Optimized for most sources: This option is selected by default and works well as 
for most sources.

 — More lift for low levels: Select this option if the source has more low level dialog that you 
want to boost.

 — Lift soft whispery sources: Select this option if the source has whispered dialog and 
background noise.

 — Reduce Loud Dialogue: When enabled, louder dialogue is ridden downward on peaks and acts 
somewhat like a “perfect limiter” where you don’t have to adjust threshold or time constants. 
Due to the “near real time” aspect, analysis occurs prior to audible playback for optimal results.

 — Lift Soft Dialogue: When enabled, finds low level dialogue and lifts and evens out material 
that is more variable in level and softer, but because the process is dialogue focused it doesn’t 
tend to raise background sounds (unless they are happening at the same time as the dialogue 
itself). More often than not, the Lift Soft Dialogue option is the most useful of the three 
options, as it makes less audible lines of dialogue more audible and naturally smooth, while 
not boosting background noise.

 — Background Reduction: When enabled, reduces background sounds by focusing on dialogue 
and gently removing them based on the internal presets (Preset menu).

 — Output Gain: Adjust the Output Gain by clicking and dragging on the Output Gain control or 
by entering a value in the numeric field (Output Gain control in dB with 0 to +6 dB range with 
.1dB resolution).

 — Clip Pitch: Lets you alter the pitch of a clip without changing the speed. Two sliders let you adjust 
clip pitch in semi tones (large adjustments, a twelfth of an octave) and cents (fine adjustments, 
100th of a semi tone).

 — Clip Equalizer: Each clip also has a four-band EQ, complete with low-pass, high-pass, and 
parametric settings for fine tuning and problem-solving audio issues at the clip level.

NOTE: There are many more refined plugins and effects for audio clips in the Audio FX 
library. If you apply any of these, the controls will appear in the Inspector’s Effects tab 
Audio section, instead of here.
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Effects
Any Fusion FX, Open FX, or Audio FX filters that have been applied to a clip can be modified here in 
their respective tabs. Different effects in the Timeline expose different controls in the Effects panel. 
Whichever panels are exposed, parameters within each panel are organized into groups, with a title 
bar providing the name of that group, along with other controls that let you control all parameters 
within that group at the same time. 

The Effects Inspector controls

These controls include:

 — Enable button: A toggle control to the left of the parameter group’s name lets you disable and re-
enable every parameter within that group at once. Orange means that track’s enabled. Gray is disabled.

 — Parameter group title bar: Double-clicking the title bar of any group of parameters collapses or 
opens them. Even more exciting than that, Option-double-clicking the title bar of one parameter 
group collapses or opens all parameter groups at once.

 — Keyframe and Next/Previous Keyframe buttons: This button lets you add or remove 
keyframes at the position of the playhead to or from every single parameter within the group. 
When the button is highlighted orange, a keyframe is at the current position of the playhead. 
When it’s dark gray, there is no keyframe. Left and right arrow buttons let you jump the playhead 
from keyframe to keyframe for further adjustment.

 — Reset button: Lets you reset all parameters within that group to their default settings.

 — Use Alpha: Checking this box applies the Open FX alpha channel to the selected clip, compositing 
it over any background elements that appear in lower tracks. If more than one alpha-modifying 
effect is applied to a single clip, the alpha channels are mixed together. 

For a detailed explanation of each of the Resolve FX plug-ins that accompany DaVinci Resolve, 
see Part 12, “Resolve FX Overview.”
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Transition
Double-clicking a transition in the Timeline opens that Transition Panel in the Inspector. 
Each transition has the following properties you can edit.

The Transition Inspector controls

 — Transition Type: The currently selected transition. You can change to any other installed 
transition by selecting one in the drop-down menu. 

 — Duration: The duration of the transition, shown in both seconds and frames.

 — Alignment: A drop-down that lets you choose the transition’s position relative to the edit point it’s 
applied to. Your choices are “Start on Edit,” “Center on Edit,” and “End on Edit.”

Additional properties that are specific to each type of transition appear in another group below. Since the 
Cross Dissolve transition is the most common transition used, its properties will be shown as an example.

 — Style: The different Dissolve transitions (Cross Dissolve, Additive Dissolve, and so on) expose this 
drop-down that lets you choose different ways for the outgoing clip to blend into the incoming 
clip during the dissolve. There are six different options to choose from:

 — Video: A simple linear dissolve; the outgoing clip fades out as the incoming clip fades in.

 — Film: A logarithmic dissolve, simulating film dissolves as created by an optical printer.

 — Additive: The outgoing and incoming clips are cross faded using the Additive composite 
mode. As a result, the transition seems to brighten at the halfway point.

 — Subtractive: The outgoing and incoming clips are cross faded using the Subtractive 
composite mode. As a result, the transition seems to darken at the halfway point.

 — Highlights: The outgoing and incoming clips are cross faded using the Lighten composite 
mode. The lightest parts of each clip are emphasized during this transition.

 — Shadows: The outgoing and incoming clips are cross faded using the Darken composite 
mode. The darkest parts of each clip are emphasized during this transition.

 — Start Ratio: Defines the percentage of completion for the transition at its first frame, 
from 0 to 100 percent. Setting the Start Ratio to anything but 0 results in the transition 
immediately appearing at a more fully cross-dissolved state from the very first frame.

 — End Ratio: Defines the percentage of completion for the transition at its last frame. Setting 
the End Ratio to anything but 0 results in the transition never fully dissolving to the incoming 
shot at its last frame.
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 — Reverse: Reverses the transition. This parameter is disabled for Dissolve transitions.

 — Ease: A drop-down that lets you apply nonlinear acceleration to the beginning, ending, or overall 
duration of a transition. The result is to add inertia to the transition from the outgoing clip to the 
incoming clip, providing a gentler change from each clip into and out of the transition.

 — None: The outgoing clip fades away to the next shot in a linear fashion.

 — In: The outgoing clip lingers as the beginning of the transition dissolves more 
slowly than the end.

 — Out: The outgoing clip fades away more quickly as the beginning of the transition dissolves 
more quickly than the end.

 — In & Out: Both the outgoing and incoming clips make slower transitions at the beginning 
and end of the dissolve, but the very center of the transition is faster as a result.

 — Custom: Lets you modify the parameters of the fade manually using the Transition Curves below.

 — Transition Curve: Allows you to manually set keyframes controlling the progress of the transition 
along its duration.

Other types of transitions display properties that are specific to that transition’s particular effect. For a detailed 
explanation of each of the transitions that accompany DaVinci Resolve, see Chapter 47, “Using Transitions.”

Image
The Image panel contains groups of parameters that correspond to every camera raw media format 
that’s supported by DaVinci Resolve. Using these parameters in the Image panel, you can override 
the original camera metadata that was written at the time of recording and make simultaneous 
adjustments to camera raw media throughout your project.

The Image Inspector controls for BRAW footage

For a detailed explanation of each of the RAW camera parameters supported by DaVinci Resolve,  
see Chapter 7, “Camera Raw Settings.”
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File
The File panel of the Inspector provides a consolidated way to view and edit a subsection of a 
clip’s most commonly used media file metadata. It’s easily accessible in the Inspector across the 
Media, Cut, Edit, and Fairlight pages. The tab is composed of the following parts:

The File Inspector controls

 — Clip Details: Presents data about the clip’s data format (codec, resolution, frame rate, etc.).

 — Metadata: Presents a reduced set of common metadata fields for quick user entry.

 — Timecode: The start timecode of the clip. This field is editable if you want to manually change 
the clip’s starting timecode.

 — Date Created: The date that the clip was created. This field is editable if you want to manually 
change the clip’s creation date.

 — Camera: Sets the Camera # metadata.

 — Reel: Sets the Reel/Card ID.

 — Scene: The Scene number of the clip.

 — Shot: The Shot letter/number of the clip.

 — Take: The Take number of the clip.

 — Good Take: This checkbox indicates if the clip is a good or circled take.

 — Clip Color: Assign a specific color to a clip that is reflected in the Timeline.

 — Name: This can be entered manually, and changes a clip’s name in that specific timeline only.

 — Comments: Add a text description to the clip.

 — Auto Select Next Unsorted Clip: When this box is checked, the next clip in the Media Pool 
is selected when you hit the Return button after entering a metadata field, and the cursor is 
automatically placed in the same field. This allows rapid sequential metadata entry without 
having to manually click to load each individual clip in the Media Pool. The Next Clip button will 
select the next clip in the Media Pool, regardless of the checkbox status.
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Chapter 31

Video and 
Audio Effects in 
the Cut Page
As you build your edit, you’ll often find it necessary to add effects 
to clips to create titles, blend clips together with compositing, 
add plugins to give clips a particular look, speed clips up or slow 
them down, or transform clips to zoom into them or move them 
around the frame. The Cut page has controls to accomplish all of 
this and more.
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Adding Transitions
You can add transitions such as dissolves or wipes to an edit to indicate a change of topic, a change of 
location, or the passage of time. You can also add a Smooth Cut transition to patch unwanted cuts in 
interview clips or other situations where there’s not a significant change in the position of the subject 
or background in the frame. Three buttons, at the bottom right of the Media Pool, make it easy to add 
and remove dissolves and Smooth Cut transitions.

The Cut, Dissolve, and Smooth Cut buttons

Adding Dissolves
Dissolves are the most standard and ubiquitous type of transition, and so they’re the easiest to create. 
Place the playhead on or near an edit you want to turn into a dissolve, and click the Dissolve button at 
the bottom left of the Media Pool. A one second Cross Dissolve will be added to the edit point that’s 
nearest to the edit point.

(Left) Moving a playhead 
near an edit point,  
(Right) Adding a dissolve

Adding Dissolve Using Keyboard Shortcuts
You can also add a dissolve by selecting one or more edit points (or moving the playhead near an edit 
you want to select and pressing V to select the nearest edit point), then pressing Command-T to add a 
dissolve, which is the standard transition.

A selected edit point

You can also add a transition that’s aligned with the beginning, middle, or end of the edit point using 
the keyboard. To do so, select an edit point, press the U key repeatedly to cycle among selecting the 
start, center, or end of the edit, then press Command-T to add the standard transition. The standard 
transition will be added with its alignment based on the edit selection you made; selecting the start of 
the edit places a transition that ends on the edit; selecting the end of the edit places a transition that 
starts on the edit, and choosing the center of the edit places a transition that is similarly centered.
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A transition that’s aligned with the beginning, center, and end of an edit point

Changing a Transition to a Cut
To remove a dissolve, thereby changing a transition to a cut, move the playhead at or near the edit 
with the dissolve, and click the Cut button, which is fast to do when you’re using the DaVinci Resolve 
Editor Keyboard which has a dedicated Cut button. 

TIP: Alternately, you can select one or more transitions in the Timeline and press the 
Delete key to remove them.

Adding Smooth Cuts
Smooth Cuts are special-purpose transitions designed to make short jump cuts in the middle of a clip 
unnoticeable. This is done by using optical flow processing to match the same features on either side 
of a cut in order to automatically morph a subject from one position to another over the duration of 
the transition.

To add a Smooth Cut:

1 Place the playhead on or near an edit.

2 Click the Smooth Cut button at the bottom left of the Media Pool. A one second Smooth Cut will be 
added to the edit point that’s nearest to the edit point.

The Smooth Cut effect works best on clips such as sit-down interviews and close-up head shots with a 
minimum of background and subject motion, and where the subject’s position on either side of the cut 
is not significantly different. A good example of when Smooth Cut is effective is when you’re cutting 
pauses, partial repeats, filler sounds such as “um” or “you know,” or other speech disfluencies out of 
an interview clip to tighten the dialog, and you want to eliminate the little “jump” that occurs at the cut 
without having to cut away to B-roll. Applying a short two or four frame Smooth Cut transition to the 
edit can make this kind of edit invisible, as long as the speaker doesn’t change position significantly 
during the cut. The more motion there is in the background of the shot, and the more the speaker 
changes position, the harder it will be to get a useful result using Smooth Cut. Although the default 
duration for any transition is one second, you’ll find that Smooth Cut transitions may work much better 
when they’re short; 2- to 6-frame Smooth Cut transitions often work best to disguise jump cuts.

Adding Other Kinds of Transitions
In order to make the selection of transitions, titles, and effects more intuitive, DaVinci Resolve shows 
each effect as a thumbnail representation in addition to the text name. This allows the user to 
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quickly scan through all the numerous options to select the appropriate effect visually, rather than 
remembering them based on name alone. You can preview transitions and titles before you place 
them on the Timeline to quickly audition multiple options before making your final decision.

Transitions Thumbnails
To preview a transition before you place it into the Timeline, ensure that “Hover Scrub Preview” is 
checked in the Transitions option menu, then simply hover your pointer over any transition in the 
Transitions tab and move it across the thumbnail. The transition will preview in the Viewer using the two 
clips nearest the Smart Indicator in the Cut page, or the two clips nearest the playhead in the Edit page.

Scrubbing over a Transition Thumbnail previews the transition in the Viewer.

Once you’ve chosen your transition, it can be applied by to any edit point by using the methods below:

Methods of adding different transitions:

 — To add a transition by dragging it from the Transitions Browser: Drag a video transition from 
the Effects Library to an edit point in the Timeline so that it’s centered at, ends at, or starts at the 
edit point. If there is no overlap between the heads and tails of the two clips, you may not be able 
to add a transition where you want.

 — To add a transition using the Transitions Browser’s contextual menu: Select one or more edit 
points (one per track), then right-click a video transition in the Effects Library and choose Add to 
Selected Edit Points. That transition will be added to every selected edit point at once.

 — To add a transition by double-clicking in the Transition Browser: You can double-click a 
transition in the Cut page’s Transitions Browser to apply it directly to the edit point referenced by 
the Smart Indicator.

 — To add a transition by using the transition alignment icons in the Transition Browser: You 
can double-click on one of three transition alignment icons at the bottom of the in the Cut page’s 
Transition Browser.

Accessing Favorited Transitions
Any transitions you’ve marked as favorites can be accessed directly in the toolbar by right-clicking the 
Smooth Cut icon, and selecting your transition from the drop-down menu. You can mark a transition 
as favorite from the effects library by hovering over the entry and clicking the star.
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Editing and Removing Transitions
Once you’ve added a transition, you can edit it in a number of different ways to work best for your 
program, both in the Timeline and in the Transition Inspector.

Methods of editing transitions in the Timeline:

 — To change a transition’s duration: Drag the beginning or end of a transition in the Timeline to 
be longer or shorter symmetrically about the current edit.

 — To move a transition from one edit to another: You can drag a transition from its current 
position to another edit point.

 — To copy a transition from one edit to another: Select a transition, then option-drag it to 
another edit point to add a duplicate transition.

 — To change a transition’s type: Drag a different transition from the Transition Browser onto the 
current one in the Timeline.

 — To remove a transition: Select a transition in the Timeline and press the Delete key.

Editing transitions in the Transition Inspector:

For more detailed control over your transition, including modifying all transition-specific parameters, 
use the Transition Inspector. For more information on each specific transition included in 
DaVinci Resolve, see Chapter 47, “Using Transitions.”

Titles
There’s a collection of title clips in the Titles Browser that you can use to add superimposed titles, 
slates, interstitial titles, lower thirds, or otherwise fulfill any textual needs your program has.

Titles Thumbnails
To audition titles before you place them into the Timeline, ensure that “Hover Scrub Preview” is 
checked in the Titles option menu, then simply hover your pointer over any thumbnail in the Titles tab. 
If the title is animated  (i.e., Fusion titles), moving the pointer across the thumbnail will preview the 
animation. Once you’ve chosen your title, you can drag it from the Titles tab to your Timeline in the 
Edit page or in the Cut page to either the upper or lower Timelines, or use the editing selection modes 
at the bottom of the tab.

Scrubbing over a Title Thumbnail previews the title in the Viewer.
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Two categories present two different kinds of titles. The “Titles” category presents simple, bare-bones 
titles that you can customize in a variety of different ways. Of the available options, the Text title is 
the most flexible. The “Fusion Titles” category presents more complicated titles that are more visually 
sophisticated and have more preset animation.

Adding Titles
You can add a title to the Timeline by opening the Titles Browser and dragging and dropping titles 
into the Timeline wherever you want them to be, just like any other clip. The default duration of a title 
clip is 5 seconds. This standard “generator” duration can be customized in the Editing panel of the 
User Preferences.

Once edited into the Timeline, titles can be moved, resized, and superimposed much like any other 
clip. Furthermore, when selected, both titles and generators expose the same Transform, Cropping, 
Speed, and Composite controls as any other clip; these controls can be used to composite titles in 
various ways to create different text effects.

Editing Titles
Once you add a title to the Timeline, the original title generators that shipped with DaVinci Resolve 
have onscreen controls that let you edit text and transform and position blocks of text directly within 
the Timeline Viewer.

Positioning and Transforming Text
So long as the Timeline playhead is positioned over a text generator that’s on top of one or more 
background clips, clicking on the text in the Timeline Viewer reveals onscreen transform controls that 
correspond to the Position, Zoom, and Rotation parameters in the Inspector.

Transforming a title’s text box in the Viewer

While dragging text to reposition it, snapping occurs at the X and Y center of the frame, as well 
as around the outer third of the frame. Holding the Shift key down while dragging a text object 
constrains movement to just the X or Y axes. Holding the Option key down turns snapping off.
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Editing Text
Double-clicking on text in the Timeline Viewer puts that text into an editable state, wherein you can 
insert a text cursor or select characters to edit the text as you would in any text editor.

Editing the text of a title in the Viewer

Editing Titles Using the Video Inspector
For more precise control of your titles, double-clicking on any title will bring up its parameters in 
the Video Inspector. Here you can change fonts, colors, drop shadows, backgrounds, etc. You can 
also adjust basic transform parameters and cropping as well. For more information on Editing Titles, 
see Chapter 48, “Titles, Generators, and Stills.”

The Title settings of Video Inspector
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Adding Resolve FX and Other Plugins
The Effects Browser reveals video and audio plugins that you can drag and drop onto to your 
clips. As far as video plugins go, there are several categories of Resolve FX plugins that accompany 
DaVinci Resolve, but if you’ve installed Resolve-compatible OFX plugins, those appear here as well, 
organized into their own categories. For audio plugins, a set of Fairlight FX plugins comes with 
DaVinci Resolve, but if you’ve installed VST plugins on macOS or Windows, or you have Audio Units 
installed on macOS, those will appear in the Audio category also. When you have a lot of video or 
audio plugins, a search field makes it easy to find the one you’re looking for.

Video Effects
Each available category of video plugins creates different sorts of image effects, such as blurs, lighting 
effects, or stylization of different kinds. To preview a video effect before placing it on a clip, ensure 
that “Hover Scrub Preview” is checked in the Effects option menu, then simply hover your pointer 
over any thumbnail in the Effects tab and move it across the thumbnail. The effect will preview in the 
Viewer using its default parameters, and scrub through the clip that is selected in the Timeline. If no 
clip is selected then it will use the clip currently under the playhead.

To activate a specific video effect on a clip, simply drag the thumbnail of the selected effect to a clip 
on the Timeline. In the Cut page, you can also double-click the thumbnail to apply the effect to the 
selected clip. To adjust the effect’s parameters, open the Effects tab in the Inspector. 

Scrubbing over an Effect Thumbnail previews that effect in the Viewer.

Audio Effects
Audio plugins let you process your audio in different ways, adjusting the tone using equalization, 
changing dynamics with compression, or adding effects such as echo, reverb, flange, or modulation. 
To activate a specific audio effect on a clip, simply drag the thumbnail of the selected effect to a clip 
on the upper or lower Timelines in the Cut page, or onto a clip in an audio track on the Edit page. 
Once the effect has been dropped on a clip, its audio plugin controls will open for you to adjust the 
plugin’s parameters.
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Generators
The various video generators included in DaVinci Resolve can be previewed by hovering your pointer 
over any thumbnail in the Generators tab. To edit a generator into your Timeline, simply grab the 
thumbnail of the generator you wish to use, and place it in your Timeline in the Edit page, or in either 
the upper or lower Timelines in the Cut page.

For more information on using all the included video and audio effects in DaVinci Resolve,  
see Chapter 46, “Editing, Adding, and Copying Effects and Filters.”

Clip Tools
Clicking the Tools button in the Viewer toolbar opens up additional categories of controls that let you 
apply various effects to the current clip, or adjust whatever effect is already applied to the current 
clip. Many of the parameters of these effects have corresponding onscreen controls that let you make 
visual adjustments directly in the Viewer.

The Tools button

Shared Controls
Every category of effect at the bottom of the Viewer has two shared controls. A toggle control at the 
far left lets you enable or disable an effect without losing whatever custom adjustments you’ve made. 
A reset control at the far right lets you reset every parameter within a particular category of controls 
to the default settings.

The Toggle button (at left) and Reset button (at right)

Transform
When you select Transform, onscreen transform controls appear that let you directly manipulate the 
image in the Viewer. You can drag anywhere within the clip’s bounding box to adjust pan and tilt, drag 
any diagonal corner to proportionally resize, drag any top/bottom/left/right side to squeeze or stretch 
width or height, or drag the center handle to rotate.

Onscreen Transform controls in the Viewer
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TIP: While dragging a clip using the onscreen controls to reposition it, holding the Shift key 
down constrains movement to just the X or Y axes.

The onscreen controls also correspond to the following editable parameters, which are also editable 
in the Video Inspector and in the Edit Sizing mode of the Sizing palette in the Color page:

 — Zoom Width and Height: Allows you to blow the image up or shrink it down. The X and Y 
parameters can be linked to lock the aspect ratio of the image, or released to stretch or squeeze 
the image in one direction only.

 — Position X and Y: Moves the image within the frame, allowing pan and scan adjustments to be 
made. X moves the image left or right, and Y moves the image up or down.

 — Rotation Angle: Rotates the image around the anchor point.

 — Pitch: Rotates the image toward or away from the camera along an axis running through the 
center of the image, from left to right. Positive values push the top of the image away and bring 
the bottom of the image forward. Negative values bring the top of the image forward and push 
the bottom of the image away. Higher values stretch the image more extremely.

 — Yaw: Rotates the image toward or away from the camera along an axis running through the 
center of the image from top to bottom. Positive values bring the left of the image forward and 
push the right of the image away. Negative values push the left of the image away and bring the 
right of the image forward. Higher values stretch the image more extremely.

 — Flip Image: Two buttons let you flip the image in different dimensions.

 — Flip Horizontal control: Reverses the image along the X axis, left to right.

 — Flip Vertical control: Reverses the clip along the Y axis, turning it upside down.

Crop
The Cut page has a set of onscreen controls you can use to directly crop the image in the Viewer. 
Each side of the image has an individual handle for cropping just that side. These parameters are also 
editable in the Video Inspector and the Color page Sizing palette.

Onscreen Crop controls in the Viewer

The Crop effects also correspond to an additional set of cropping parameters, with an additional 
control for softness:

 — Crop Left, Right, Top, and Bottom: Lets you cut off, in pixels, the four sides of the image. 
Cropping a clip creates transparency, so whatever is underneath shows through.

 — Softness: Lets you blur the edges of a crop. Setting this to a negative value softens the 
edges inside of the crop box, while setting this to a positive value softens the edges outside 
of the crop box.
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Dynamic Zoom
The Dynamic Zoom controls, which are off by default, make it fast and easy to do pan and scan effects 
to zoom into or out of a clip. A set of two onscreen controls let you create a Dynamic Zoom effect. 
A green box shows the starting size and position of the animated transform, while a red box shows 
the ending size and position of the animated transform. Drag anywhere within either bounding box to 
reposition either the start or the end of the animated effect, and drag any of the corners to adjust the 
size at the start or end. A motion path appears to show you motion that’s being created. Adjusting the 
Dynamic Zoom controls automatically enables dynamic zoom. These controls are also available in the 
Video Inspector.

Dynamic Zoom controls in the Viewer

These controls correspond to two parameters in the toolbar (Dynamic Zoom is also editable in the 
Video Inspector).

 — Zoom/Pan/Angle Presets: Let you enable or disable preset positions for the zoom level, pan 
location, and angle of this effect.

 — Swap: This button reverses the start and end transforms that create the dynamic zoom effect.

 — Ease Buttons: Lets you choose how the motion created by these controls accelerates. You can 
choose from Linear, Ease In, Ease Out, and Ease In and Out.

TIP: While dragging dynamic zoom outlines to reposition them, holding the Shift key down 
constrains movement to just the X- or Y-axis.

Composite
Two controls let you create transparency and use composite modes to create different compositing 
effects (also called Blend modes or Transfer modes). These controls also editable in the 
Video Inspector.

Composite controls in the Viewer

 — Composite Modes: Composite modes blend two superimposed clips together on the Timeline 
using different kinds of math to achieve differing results, to create transparency effects, increase 
image exposure, and combine multiple clips into a single image in many creative and useful 
ways. All Composite modes interact with the Opacity slider. For more information on what each 
Composite mode does, see Chapter 50, “Compositing and Transforms in the Timeline.”
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 — Opacity: This slider lets you make a clip more transparent, over a range from 0 (totally 
transparent) to 100 (totally opaque). When set to a value less than 100, the selected clip is mixed 
with whatever video clip is underneath it on the Timeline, using the Composite mode that’s 
currently selected. If no clip appears underneath the Timeline, then the clip is mixed with black 
and will work similarly to a fade.

TIP: If a superimposed video or still image clip in the Timeline has an alpha channel, that 
alpha channel automatically creates transparency within that clip, compositing it against 
whatever is in the track underneath. There’s no need for you to do anything for this to work.

Speed
Speed effects let you speed up, slow down, or otherwise change the playback speed of clips in the 
Timeline. When you change the speed of a clip, that clip’s duration also changes to reflect a shorter 
clip that plays faster, or a longer clip that plays more slowly. Speed effects change both video and 
audio playback, but the audio of sped up or slowed down clips is always pitch corrected. Speed effects 
applied in the Cut page also appear and are editable via several different methods in the Edit page 
timeline and the Video inspector.

Speed Effects controls in the Viewer

 — Speed: Changing this value lets you speed up or slow down playback by a simple numeric 
multiplier. You also have the option of choosing a negative value to create reverse speeds.

 — Duration: When you retime a clip, the Duration field lets you see how the change you’re making 
affects the new duration based on the original duration of the clip with no speed effect applied.

Stabilization
The Image Stabilization controls use warping and/or translation to let you smooth out or even lock 
unwanted camera motion within a clip. The analysis is performed in such a way as to preserve the 
motion of individual subjects within the frame, as well as the overall direction of desirable camera 
motion, while correcting for unsteadiness. 

Stabilization controls in the Viewer

To stabilize an image, all you need to do is to choose a Stabilization Method from the drop-down (see 
below for more information), and then click the Stabilize button. DaVinci Resolve analyzes the current 
clip, and applies a stabilization effect.
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The rest of the stabilization controls let you refine the result. Whenever you adjust any of these 
parameters, you must click the Stabilize button again for the effect to be updated.

 — Stabilization Method: A drop-down menu provides three different options that determine how 
the selected clip is analyzed and transformed during stabilization. You must choose an option 
first, before clicking the Stabilize button, because the option you choose changes how the 
image analysis is performed. If you choose another option, you click the Stabilize button again to 
reanalyze the clip.

 — Perspective: Enables perspective, pan, tilt, zoom, and rotation analysis and stabilization.

 — Similarity: Enables pan, tilt, zoom, and rotation analysis and stabilization, for instances where 
perspective analysis results in unwanted motion artifacts.

 — Translation: Enables pan and tilt analysis and stabilization only, for instances where only 
X and Y stabilization gives you acceptable results.

 — Stabilize: Clicking this button on a previously unstabilized clip analyzes the motion in that clip and 
applies an initial smoothing effect. Clicking this button on a clip that’s already been analyzed lets 
you recalculate a modified stabilization effect.

TIP: These controls are identical to those found in the Video Inspector and the Color page 
Tracker palette, and populate the same image processing data. This means that you can use 
the Stabilization found on the Cut page, and then use the stabilization graph and controls 
found in the Color page to refine the results, if necessary.

Lens Correction
Lens Correction presents two controls that let you either correct lens distortion in the image, or add 
lens distortion of your own for effect. These controls are also editable in the Video Inspector and Color 
page Edit Sizing palette.

Lens Correction controls in the Viewer

 — Analyze: Automatically analyzes the frame in the Timeline at the position of the playhead 
for edges that are being distorted by wide angle lens. Clicking the Analyze button moves the 
Distortion slider to provide an automatic correction. If you’re analyzing a particularly challenging 
clip, a progress bar will appear to let you know how long this will take.

 — Distortion: Dragging this slider to the right lets you manually apply a warp to the image that lets 
you straighten the bent areas of the picture that can be caused by wide angle lenses. If you clicked 
the Analyze button and the result was an overcorrection, then dragging this slider to the left lets 
you back off of the automatic adjustment until the image looks correct.
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Color
The Color section of the Tools consists of only one option: Auto Color. The Auto Color command 
provides a quick way to automatically balance the blacks and whites of a clip based on the current 
frame at the position of the playhead. Using advanced algorithms, based on the DaVinci Neural 
Engine, it provides superior results when automatically adjusting color balance and contrast. 

For more details on using Auto Color, see Chapter 127, “Automated Grading Commands and 
Imported Grades.”

Color controls in the Viewer

Audio
A slider lets you adjust audio levels of the current clip in the Viewer, making the volume of that audio 
clips softer or louder. This is identical to each clip’s volume setting in the Edit and Fairlight pages.

Audio controls in the Viewer

Smart Reframe (Studio Version Only)
The Smart Reframe feature in DaVinci Resolve makes it easier to quickly reframe material across 
extreme aspect ratio changes. It’s useful for situations where you’ve shot a 16:9 horizontal video and 
find yourself needing to create a vertically-oriented 9:16 version for mobile phones and social media 
deliverables or using 4:3 archival footage in a 2.39:1 widescreen movie. Smart Reframe can be used 
manually or automatically executed using the DaVinci Resolve Neural Engine.

Smart Reframe in action with the Reference Point bounding box active (right)

The Smart Reframe tool is found in the Sizing tab of the Inspector and is available in both the Cut and 
Edit pages.
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To use the Smart Reframe tool:

1 Duplicate your Timeline, right-click the Timeline and choose Timelines > Timeline Settings, and 
click Use Custom Settings to change the Timeline Resolution to the aspect ratio needed for 
delivery. Make sure that “Mismatched resolution files” is set to “Scale full frame with crop,” and 
click OK. 

2 Select one or more clips you want to reframe, and open the Inspector to the Video tab.

3 Open the Smart Reframe controls, leave the Object of Interest drop-down menu set to Auto (if 
you’ve selected more than one clip, Auto is the only setting available), and click “Reframe.” DaVinci 
Resolve will analyze your footage and should automatically adjust each individual clip’s position to 
a more aesthetically pleasing framing. 

4 (Optional) If the “Auto” setting does not give you desirable results for a particular clip, you can 
manually select the main subject using the following steps.

a) To manually select the subject area, choose “Reference Point” from the Object of Interest 
drop-down menu, and click the Target icon just to the right of the menu. This automatically 
sets the Viewer mode to Smart Reframe, exposing the onscreen controls for choosing a 
reference.

b) Drag the Reference Point bounding box around the main subject of interest in the frame. You 
may use the Transform controls directly above in the Inspector to move the source clip around 
if your subject is outside the current framing. 

c) Click “Reframe.”

The Inspector’s Smart Reframe controls 
showing the manual reference point selected

DaVinci Resolve locks onto and, if necessary, tracks your subject using the reference you’ve selected, 
automatically panning and scanning the original clip as needed to keep the reference within the new 
aspect ratio. While involving a bit of manual adjustment, this function still dramatically reduces the 
time involved in pan and scanning footage by manually adjusting and keyframing the sizing controls.
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Chapter 32

Quick Export
Once you’ve finished your program and you want to share it with 
others, you can use the Quick Export button to output the contents 
of the Timeline as a self-contained file in one of a variety of different 
formats in order to share it with people.

Contents
Quick Export  591
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Quick Export
You can choose File > Quick Export to use one of a variety of export presets to export your program 
from any page of DaVinci Resolve. You can even use Quick Export to export and upload your program 
to one of the supported video sharing services, including YouTube, Vimeo, Twitter, and Dropbox. 

To use Quick Export:

1 In the Cut, Edit, Fusion, or Color page, optionally set In and Out points in the Timeline to choose a 
range of the current program to export. If no timeline In or Out points have been set, the entire 
timeline will be exported.

2 Choose File > Quick Export or click the Quick Export icon at the upper right-hand corner of 
the Cut page.

3 Select a preset to use from the top row of icons in the Quick Export dialog, and click Export.

4 Choose a directory location and enter a file name using the Export dialog, then click Save. 
A progress bar dialog appears to let you know how long the export will take.

The Quick Export dialog

TIP: To use custom export options, you can use the Deliver page. For more information on 
creating custom presets for rendering, see Chapter 187, “Rendering Media.”
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